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Communications regulation information

FCC statement
This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. See instructions if interference to
radio or television reception is suspected.

Radio and television interference
The equipment described in this manual generates, uses, and can radiate radio-frequency
energy. If it is not installed and used properly—that is, in strict accordance with Apple’s
instructions—it may cause interference with radio and television reception.

This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. These specifications are designed
to provide reasonable protection against such interference in a residential installation. However,
there is no guarantee that interference will not occur in a particular installation.

You can determine whether your computer system is causing interference by turning it off. If
the interference stops, it was probably caused by the computer or one of the peripheral devices.

If your computer system does cause interference to radio or television reception, try to correct
the interference by using one or more of the following measures:
m Turn the television or radio antenna until the interference stops.
m Move the computer to one side or the other of the television or radio.
m Move the computer farther away from the television or radio.
m Plug the computer into an outlet that is on a different circuit from the television or radio.

(That is, make certain the computer and the television or radio are on circuits controlled by
different circuit breakers or fuses.)

If necessary, consult an Apple-authorized service provider or Apple. See the service and support
information that came with your Apple product. Or, consult an experienced radio/television
technician for additional suggestions. 

IMPORTANT Changes or modifications to this product not authorized by Apple Computer, Inc.,
could void the FCC Certification and negate your authority to operate the product.

This product was tested for FCC compliance under conditions that included the use of Apple
peripheral devices and Apple shielded cables and connectors between system components. It is
important that you use Apple peripheral devices and shielded cables and connectors between
system components to reduce the possibility of causing interference to radios, television sets,
and other electronic devices. You can obtain Apple peripheral devices and the proper shielded
cables and connectors through an Apple-authorized dealer. For non-Apple peripheral devices,
contact the manufacturer or dealer for assistance.

viiCommunicat ions Regulat ion In format ion
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DOC statement
DOC Class B Compliance This digital apparatus does not exceed the Class B limits for radio
noise emissions from digital apparatus as set out in the interference-causing equipment standard
entitled “Digital Apparatus,” ICES-003 of the Department of Communications.

Observation des normes—Classe B Cet appareil numérique respecte les limites de bruits
radioélectriques applicables aux appareils numériques de Classe B prescrites dans la norme 
sur le matériel brouilleur : “Appareils Numériques”, NMB-003 édictée par le ministre des
Communications.

VCCI statement
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Welcome to the Apple Color OneScanner. With the Color OneScanner and
the Apple OneScanner Dispatcher application program, you can

m scan an image or document and save it in a format you can use with
compatible graphics and page-layout applications

m print or fax saved images using convenient drag-and-drop icons

m retrieve saved images using thumbnail-view archives

m use the Apple Color OneScanner plug-in module to scan directly into
applications compatible with Adobe™ Photoshop plug-ins

1 Welcome
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System requirements

The Apple Color OneScanner works with Macintosh computers with the
following configurations:

m System software version 7.5 or later

m 68030 or later processor

Scanning and scanned images require significant space on your computer and
significant free space on a hard disk. 

m You need at least 12 megabytes (MB) of random-access memory (RAM).
The OneScanner Dispatcher software requires at least 3 MB of free RAM. 
The TextBridge OCR software requires at least 4 MB of RAM. If you 
use the two applications at the same time, these RAM requirements are
additive (you need at least 7 MB of available RAM, plus the RAM
required by your system). Scanning operations improve with more RAM.

m Your hard disk needs to have at least 20 MB of disk space available.

What you need to know

If you’re new to the Macintosh—or to computing in general—you need to 

m read the information that came with your computer

m explore the interactive learning products you received

These materials will explain the basic Macintosh skills you need to have
before you set up and use your scanner.

2 Chapter  1
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In this manual

This manual provides step-by-step instructions and reference information for
the Apple Color OneScanner and the OneScanner Dispatcher application. 

Chapter Title Provides information about. . .

1 Welcome This manual and system requirements

2 Setting Up the Scanner Assembling and connecting the scanner 
to your Macintosh computer

3 Installing the Scanner Installing the OneScanner Dispatcher
application and related softwareSoftware

4 Scanning Images Using the scanner and the OneScanner
Dispatcher application to scan, save, print, 
and fax; using drag-and-drop icons

5 Editing Scanned Images Using the OneScanner Dispatcher application 
to change your scanned images

6 Scanning Text Using the OneScanner Dispatcher application 
to scan text

7 Dispatcher Commands The software, organized by menus and tools

8 Scanner Maintenance Basic maintenance procedures

9 Using the Automatic Installation and use 
Document Feeder

10 Using the Transparent Installation and use, including a section 
Media Adapter on troubleshooting

3Welcome
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In the appendixes

The appendixes provide supplementary information about the Apple Color
OneScanner.

Appendix Title Provides information about. . .

A Technical Specifications Technical features of the Apple Color
OneScanner

B Troubleshooting Diagnosing and correcting problems

C Assembling a SCSI Chain Connecting the scanner and other 
SCSI devices

4 Chapter  1
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This chapter shows you how to set up the Apple Color OneScanner. You’ll
find instructions for

m unpacking, carrying, and placing the scanner

m connecting the scanner to a Macintosh computer

m plugging in the scanner and switching it on

m safely using your scanner

5
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Unpacking the scanner and accessory kit

Make sure you have the items shown here. 

You may have received additional third-party software with your scanner.

Choosing a SCSI cable

The Apple Color OneScanner connects to your Macintosh through a Small
Computer System Interface (SCSI) cable (pronounced “SKUH-zee”). This
cable provides for high-speed communication between the computer and a
SCSI device, or devices, connected to the computer.

You will need to purchase a SCSI cable to connect your Apple Color
OneScanner to the Macintosh. If you have a Macintosh IIfx, you also need a
special terminator. For more information about connecting the scanner to a
Macintosh IIfx or PowerBook computer, see Appendix C.

Apple recommends that you purchase only Apple-brand SCSI cables, which
are properly shielded for trouble-free operation. You can purchase SCSI
terminators and cables from your authorized Apple reseller.

Color OneScanner

Color OneScanner software
Quick Start card for OneScanner
Dispatcher software

Color OneScanner
User’s Manual

Power cord

6 Chapter  2
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To connect the scanner directly to the Macintosh

To connect the scanner directly to your Macintosh computer, you need a SCSI
system cable. 

To connect the scanner at the end of a SCSI chain

If you already have an external SCSI device (such as a SCSI hard disk drive)
attached to your Macintosh computer, Apple recommends that you connect
the scanner at the end of the SCSI chain.

To make this connection, you need a SCSI peripheral cable.

To use a different arrangement (configuration)

For information about connecting the scanner in the middle of a SCSI chain,
see Appendix C, “Assembling a SCSI Chain.”

SCSI peripheral cable

SCSI system cable (one end
is smaller than the other)

7Set t ing Up the Scanner
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Choosing the right location

Before you set up the scanner, choose a work area that’s convenient for you
and that meets the physical requirements of the scanner:

m a level, stable surface, such as a desk or table

m a grounded three-pin power outlet

m space around the scanner for easy access to the on/off switch

Environmental considerations
m Make sure you allow space for adequate ventilation so the scanner does not

overheat. 

m If relative humidity is low, use a humidifier or an antistatic mat to avoid
electrostatic buildup. Avoid dusty areas, places where the scanner will be
exposed to salty air or corrosive gases, and locations where temperature
and humidity levels vary significantly. 

m Avoid placing the scanner in direct sunlight or exposing it to open flames.

m Place the scanner on a surface that is free from vibrations.

Allow clearance
above the scanner so
the top cover opens easily.

Leave enough room to place
large originals on the 
scanner glass.

Allow enough space
at the back of the
scanner for the
power cord and
SCSI connectors.

On/off switch

8 Chapter  2
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Safety precautions
m Don’t place the scanner where anyone can walk on the power cord, and do

not allow anything to rest on the cord. If you must use an extension cord,
be sure the total length of the power cord plus the extension cord is not
greater than 16.5 feet (5 meters).

m Keep the scanner away from equipment that might cause electromagnetic
or radio frequency interference, such as radio transmitters, cordless
telephone base units, television sets, copy machines, and heating and 
air-conditioning equipment.

Carrying the scanner

The Apple Color OneScanner is a complex electronic device. Handle the
scanner carefully as you set it up.

To carry the scanner:

1 Make sure the scanner carriage is locked.

For information, refer to “Locking and Unlocking the Scanner,” later in 
this chapter.

2 Grasp the scanner by its side edges, toward the back:

3 Carry the scanner flat, without tipping it on its ends or sides, and keep it stable.

Grasp scanner here.

9Set t ing Up the Scanner
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Apple Color OneScanner at a glance

Now that you’ve unpacked the scanner and accessory kit and found a good
location, take a moment to identify the most important parts of your new
Apple Color OneScanner.

Scanner cover

Power cord socket

Capped connector for Automatic Document
Feeder or Transparent Media Adapter

SCSI connector (small)

SCSI connector (large)

SCSI ID and
termination selector

On/off switch

Power on light

10 Chapter  2
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Locking and unlocking the scanner

The Apple Color OneScanner carriage is locked during shipment. Make sure
the carriage is unlocked. The scanner will not work if the carriage is locked.

If in the future you need to ship the scanner for service or move it to a
different place, be sure to relock the scanning unit. 

To lock or unlock the scanning unit:

1 Grip the scanner top cover on both sides and lift it off.

2 Use a coin to turn the lock to the locked or unlocked position.

Take care not to scratch the scanner glass.

Unlocked position

Locked position

Grasp cover here.

11Set t ing Up the Scanner
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Setting the SCSI ID number and termination

You may not need this step. You can skip this topic if 

m the scanner is the only external SCSI device to be connected to your
Macintosh

or

m you’re setting the scanner up as the last device in a SCSI chain 

If you need to change the SCSI ID number or termination setting, do so after
you review this topic and before you connect any cables.

About the SCSI ID number

A SCSI ID selector on the back of the scanner identifies the Macintosh port
through which scanner information travels. The SCSI ID number is preset to
2. This factory setting is valid if you have no other SCSI device occupying
SCSI ID number 2.

You can change the SCSI ID number if your configuration requires a different
number. 

Numbers to avoid:  Don’t assign numbers 0, 3, or 7 to the scanner. The default
setting for the Macintosh computer is 7. The default setting for an internal
CD-ROM player is 3. The default setting for the internal hard disk drive
inside your Macintosh is 0. Make sure you use a number that is not assigned
to any other SCSI device. Each ID number must be unique.

SCSI ID selector
switch set to 2 “on”
(default setting)

0 1
2

3
4

5

6

701

2

3
4

5

6 7
2

0 1
2

3
4

5

6

701

2

3
4

5

6 7

To choose a SCSI ID with
termination on, use the
“I” side of the dial. To
choose a SCSI ID with
termination off, use the
“O” side. The ID numbers
are the same on
both sides. 

12 Chapter  2
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About SCSI termination

The SCSI selector on the Apple Color OneScanner also works as a selector
for internal SCSI termination. Termination is set to “on” at the factory. 

If the scanner is the only SCSI device connected to your Macintosh or if you
place the scanner as the last device in a SCSI chain, the “on” setting is correct
and doesn’t need to be changed.

If the scanner is one device in a SCSI chain, but not the last device, you must
turn off termination. See Appendix C for details.

Connecting the scanner to your Macintosh

You’re now ready to connect the scanner to your Macintosh computer.

If you’re connecting the scanner to a Macintosh PowerBook, see the manual
that came with your computer for instructions on connecting SCSI devices.

WARNING Before you begin, make sure that the power to the scanner,
your computer, and any connected devices is switched off. If the power
is on while you connect or disconnect SCSI cables, you can damage the
system.

If you need to connect more than one SCSI device to your computer,
follow the instructions above or those in Appendix C, “Assembling a
SCSI Chain.” Correct placement of the devices and the cable terminator
(if one is required) is important. You can damage your equipment if you
connect the devices the wrong way.

13Set t ing Up the Scanner
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Connecting the SCSI cable

Follow these steps to connect the scanner directly to your computer. 

1 Plug the large end of the SCSI cable into the back of the scanner, and push the retaining
clips into the tabs.

2 Plug the small end of the SCSI connector into the back of the Macintosh, as shown.

3 Gently tighten the thumbscrews on the cable.

You’re now ready to attach the power cord.

SCSI cableRetaining clipRetaining tab

14 Chapter  2
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Connecting the power cord

Follow these steps to connect the power cord to the scanner:

1 Align the holes in the socket end of the power cord with the pins of the power cord
socket on the back of the scanner.

2 Plug the socket end of the power cord into the pins on the scanner.

3 Plug the other end of the power cord into a standard electrical outlet that accepts a
three-pronged plug.

You’re now ready to switch the scanner on and install the scanner software.

Power cord plug

WARNING This equipment is intended to be electrically grounded. Your
Apple Color OneScanner is equipped with a three-wire grounding
plug—a plug that has a third (grounding) pin. This plug will fit only a
grounded AC outlet. This is a safety feature. If you are unable to insert
the plug into the outlet, contact a licensed electrician to replace the
outlet with a properly grounded outlet. Do not defeat the purpose of the
grounding plug!

15Set t ing Up the Scanner
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Switching the power on

The scanner and other SCSI devices require that you switch the power on in a
certain sequence. 

To switch the scanner on:

m Press the on/off switch.

Switching the power on

Equipment attached to computer Switch on in this order

Scanner only Scanner > computer

Scanner plus other devices Scanner > other devices > computer

If you start the computer before you turn on the scanner, the computer won’t
be able to find the scanner.

“O” is for off,
and “I” is for on.

16 Chapter  2
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Important safety information

Any electrical device, when operated improperly, can be hazardous. Before
you use your scanner, become familiar with these important safety
precautions:

m Don’t use the scanner near water.

m Use the power cord that is appropriate for use in the country in which you
use the scanner.

m Never drop or insert objects of any kind into the scanner. 

m Never spill liquid of any kind on or into the scanner. Should an object or
liquid come into contact with high-voltage points inside the scanner, a fire
could occur, or you could be exposed to electrical shock.

m If liquid of any kind is accidentally spilled on or into the scanner,
immediately switch the power off and disconnect the power cord.

m Don’t allow young children to handle power cords or cables.

m Be careful not to drop the scanner or allow it to collide with other objects.

Where to go from here

You’ve now completed the hardware part of scanner setup. The next step is to
install the scanner software. See Chapter 3, “Installing the Scanner Software,”
for instructions.

17Set t ing Up the Scanner
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This chapter tells you how to install the software you need to use the Apple
Color OneScanner. You’ll find instructions for

m installing the Apple OneScanner Dispatcher application and related
software

m installing the Apple Color OneScanner plug-in module for use with a
compatible graphics application

m assigning the Xerox TextBridge application for use with the scanner
software

m installing Kai’s Power Tools and Convolver plug-ins from MetaTools 
(plug-in filters which come with the Color OneScanner 1200/30)

About the disks

To install the scanner software, you need the disks that came with your
scanner (in the accessory kit). You should have two disks: OneScanner
Dispatcher Disk 1 and Disk 2. These disks contain

m the Installer, a system program you use to install everything you need to
use the scanner

m the scanner driver

m a Read Me file, which provides information available too late to be
included in this manual, and the SimpleText application program for
viewing the Read Me file 

19
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m ColorSync, a system program that records color information about scanned
images so the colors stay consistent in different applications and on
different devices, such as printers and monitors 

Most of the files on these disks are compressed. To install them, you must use
the Installer.

Your scanner package may include additional software. If you want to install
and use the software, see the on-disk documentation that comes with the
software for installation and user instructions. 

IMPORTANT Apple recommends that you make backup copies of the disks and
store the originals in a safe place. If you need instructions for copying disks,
see your Macintosh user’s manual. 

Installing the scanner software

To install the scanner software and start scanning, remember that you 
need at least 20 MB of space available on your hard disk. You must have
system software version 7.5 or a later version to use the scanner with your
Macintosh computer.

Note:  If you’re using a system with 8 MB of RAM, Apple recommends that
you turn on Virtual Memory. 

To install the software:

1 Turn off any automatic virus-detection programs and restart your Macintosh computer.

If you leave these programs on, problems may occur. You can turn the virus-
detection programs back on after installation is complete.

2 Insert OneScanner Dispatcher Disk 1 into a floppy disk drive. 

If necessary, open the icon for OneScanner Dispatcher Disk 1. A window
appears, showing the contents of the disk.

20 Chapter  3
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3 Double-click the Installer icon.

After a welcome screen appears (click Continue), an installation dialog 
box opens.

Easy Install:  Apple recommends that you use the Easy Install process for
your scanner software. Easy Install places all necessary files on your hard disk
and updates any existing files as needed.

Custom installations:  The Installer has a custom feature that allows you to
choose specific items from a list and have them installed. To use this feature,
click Easy Install in the Install dialog box to open a pop-up menu, and choose
Custom Install. Then follow the instructions on the screen. 

4 Click Install and follow the instructions on the screen.

A status box keeps you informed of progress during installation.

5 When the process is complete, a message tells you that installation was successful.

21Insta l l ing the Scanner  Sof tware
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6 If the scanner is not on, switch it on.

7 Click Restart.

Installing the plug-in module for use by other applications

The Apple Color OneScanner plug-in module allows you to scan images
directly into applications compatible with Adobe Photoshop plug-ins. The
user’s manual for your application will tell you where the application requires
you to place the plug-in module.

Before you install the plug-in modules, you must install the Apple Color
OneScanner software, as described earlier in this chapter. 

To install the plug-in module for use by another application:

1 Open the Apple Color OneScanner folder (the one you just installed on your hard disk).

2 Open the Plug-ins folder, select the plug-in icon, and choose Duplicate or Make Alias
from the File menu (Finder).

A copy or an alias of the plug-in module is created. (An alias takes up no
space on your disk, a big advantage. For information about using aliases, see
your Macintosh user’s manual or Apple Guide, Apple’s online help.)

3 Move the copy or the alias to the location you want.

The original plug-in must remain in the Plug-in folder in the Apple Color
OneScanner folder or you will not be able to create new scans with the
OneScanner Dispatcher application.

22 Chapter  3
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4 Drag the copy of the Apple Color OneScanner plug-in icon to the folder suggested by the
user’s manual for your graphics application.

5 When the plug-in icon is where you want it, delete the word “copy” and the space before
the word.

6 If the user’s manual for your application suggests a restart, restart your computer.

You can now scan images directly into the graphics application.

Assigning the Xerox TextBridge 3.0H application to the Dispatcher

The TextBridge application, from Xerox Imaging Systems, Inc., analyzes an
image of scanned text and converts each character into a form of text a
computer can recognize. This process of text conversion is called optical
character recognition (OCR).

The TextBridge OCR application comes with the Apple Color OneScanner.
You may have other OCR software that you prefer to use. The instructions
that follow work for any compatible OCR application. 

To assign the TextBridge application for use with the Apple Color
OneScanner:

1 First, install the TextBridge application on your Macintosh computer.

Follow the instructions in the TextBridge user’s manual.

2 Open the Apple Color OneScanner folder and double-click the OneScanner 
Dispatcher icon.

23Insta l l ing the Scanner  Sof tware
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The Dispatcher window opens on the Macintosh desktop. 

You’ll find complete information about using the Dispatcher window in
Chapter 4, “Scanning Images.” For now, continue following these steps to
assign TextBridge to the Dispatcher. 

3 In the Dispatcher window, double-click the icon labeled Unassigned OCR.

A dialog box opens.

4 Move through folders (and disks, if necessary) to find the TextBridge application.

24 Chapter  3
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5 Double-click the TextBridge application name, or select the name and click Select.

The dialog box closes. TextBridge appears as the OCR icon.

Like the other icons in this area of the Dispatcher window, the OCR icon is a
drag-and-drop icon. To move text images into your OCR application, drag
them to the OCR icon. For more information, see Chapter 6, “Scanning Text.”

Setting up ColorSync

ColorSync is a system extension that helps maintain color consistency among
different devices, such as scanners, monitors, and printers.

ColorSync is not turned on when you install the scanner software. If you want
to use ColorSync as you work, you must turn it on and set preferences. For
information, see “Setting ColorSync Preferences” in Chapter 5.
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Installing Kai’s Power Tools and Convolver

Kai’s Power Tools and Convolver are plug-in modules that provide filters
compatible with Adobe PhotoShop and similar applications. To install 
these applications, follow the instructions in the user’s manuals that came
with them. 

During installation, a dialog box appears that lets you select the Plug-Ins
folder (inside the Apple Color OneScanner folder) as the correct destination
for the new plug-in modules.

If you also need to place these plug-in modules in a special folder for an
application you are using, make copies or aliases of the modules. Then drag
the copies or aliases to the application’s folder. (For details, see the user’s
manual for that application.) It is important to leave the original plug-in
modules in the Plug-Ins folder inside the Apple Color OneScanner folder.

Where to go from here

You’ve now completed the installation of the scanner hardware and software. 

Will you be using the scanner only for images?

m For a quick overview of the scanner software, see the Quick Start card for
the OneScanner Dispatcher application. 

m For details on scanning and customizing scanner settings, see Chapter 4,
“Scanning Images.”

Will you be using the scanner for optical character recognition (OCR) text scanning?

m For a quick introduction to text scanning, see Chapter 6, “Scanning Text.” 

m For complete instructions for using the TextBridge application or another
compatible OCR application, see the documentation that came with 
your software.
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This chapter provides complete instructions for using the OneScanner
Dispatcher application program with the Apple Color OneScanner. The
chapter shows how to

m choose originals and align them on the scanner

m use the OneScanner Dispatcher application to scan, print, fax, save, and
retrieve saved images

m use the drag-and-drop feature to print or fax saved images 

m add drag-and-drop icons for compatible graphics applications

m scan an image directly into a compatible graphics application with the
Apple Color OneScanner plug-in module
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What you can scan

You can scan almost anything you can put on the scanner glass:

m photographs and flat art

m drawings and calligraphy

m line art

m bound documents such as magazines and books 

You should be aware of a few limitations:

m You cannot completely scan an item that is larger than 8.5 by 11.7 inches.
The optional Automatic Document Feeder extends the scanning area to 8.5
by 14 inches.

m You cannot scan items that weigh more than 4.4 lb. (2 kg). Heavier items
may damage the scanner glass.

m It is illegal to scan certain official and copyrighted documents. Please see
“Copyright Regulations (USA)” at the end of this chapter for a summary of
restrictions in the United States.

Text and optical character recognition:  You can scan printed text and convert
the image to text that can be read by a computer. To do this, you need special
optical character recognition (OCR) software. Xerox TextBridge 3.0H OCR
software comes with the Apple Color OneScanner. For an introduction to
TextBridge, see Chapter 6, “Scanning Text,” in this manual. For information
about using TextBridge, see the TextBridge user’s manual. 

Preparing originals
Follow these guidelines to prepare originals for scanning.

m Flatten out curled or wrinkled originals before you place them on the
scanner glass.

m When you scan large, bound documents, you may find it helpful to remove
the scanner top cover. For information, see “Removing and Replacing the
Scanner Cover,” later in this chapter.
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Aligning a single original

To ensure that the alignment of the scanned image matches the alignment of
the original, you can use the alignment mark.

To align an original page on the document glass:

1 Lift the scanner cover, as shown.

2 Place the original face down on the document glass.

Position the original so the top edge is toward the rear of the document glass
and the top-right corner points to the alignment mark, as shown.

3 See “Opening the OneScanner Dispatcher Application,” later in this chapter, for
complete scanning instructions.

Alignment mark

Original face down
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Aligning bound originals

You can scan pictures or text in bound books with the Apple Color
OneScanner. To simplify the placement of large bound originals, you may
wish to remove the scanner cover. For instructions, see the next topic,
“Removing and Replacing the Scanner Cover.”

To align bound originals:

1 Open the bound document and place the page you want to scan face down on the
document glass.

2 Position the page to cover as much of the glass as possible. 

3 See “Opening the OneScanner Dispatcher Application,” later in this chapter, for
complete scanning instructions.

Alignment mark
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Removing and replacing the scanner cover

When you work with a bound document, you may wish to remove the
scanner cover. Removing the cover makes it much easier to align the pages of
bound items and makes the alignment more accurate.

To remove the scanner cover:

1 Position the scanner so the front is facing you.

2 Grip the cover as shown and lift it straight up off the scanner.

To replace the scanner cover:

1 Insert the metal posts into the scanner.

2 Gently push the cover down.

Grasp cover here.

Grasp cover here.
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Opening the OneScanner Dispatcher application

To start scanning, you need to open the OneScanner Dispatcher application. 

1 Double-click the OneScanner Dispatcher icon.

The Dispatcher window opens. 

2 To hide (or show) the bottom half of the window, click the arrow.

You’ll find information about using the Dispatcher window throughout 
this chapter.

3 To move the Dispatcher window anywhere on the desktop, drag it by its title bar.

You can leave the window in a convenient spot for handy access when you’re
ready to scan or edit images.
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How the OneScanner Dispatcher application is organized

The Dispatcher window is the control center for your scanning activities. 

Buttons

You use the buttons on the top half of the Dispatcher window to scan 
new images, send new images to your printer or a fax application, open 
and edit images you’ve already scanned and saved, and view images in
thumbnail form.

Example:  If you have a letter on the scanner glass and want to fax the letter,
you use the Scan Router button to send the scanned image of the letter to your
fax application.
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Drag-and-drop icons

You use the icons on the bottom half of the Dispatcher window to drag and
drop saved images you want to send to a printer, a fax application, an optical
character recognition (OCR) application, or an application you add, such as a
graphics application.

Example:  You may have an archive full of images you’ve scanned. If you want
to fax one of the images, you simply drag the image’s thumbnail from an
image archive and drop the thumbnail onto the Fax icon. Your fax application
opens, allowing you to address and transmit the fax without going through a
separate operation. 
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Scanning with automatic settings

The OneScanner Dispatcher application comes preset to scan most color and
black-and-white originals. For your first scanned images, you may wish to
work with the automatic settings. Later, when you’re ready for fine-tuning,
you can customize the settings.

To scan a document and create a new image:

1 Put the original document on the scanner glass and close the scanner cover.

For more information, see “Preparing Originals,” earlier in this chapter.

2 If necessary, open the OneScanner Dispatcher application by double-clicking its icon.

The Dispatcher window opens:

Alignment mark

Original face down
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3 Click Scan.

The Apple Color OneScanner dialog box opens.

IMPORTANT If you have a PowerBook and cannot see the controls at the
bottom of the dialog box, you must change the setting in your Monitors
control panel. Open the control panel, click Options, and choose 640 x 400. 

4 To make sure the correct options are selected, check the Set Up pop-up menus.

Source If you’ve attached an Automatic Document Feeder or Transparent
Media Adapter, you need to specify it as the source of the scan. Choose
Feeder or Transparency from the Source pop-up menu.

Image Choose the type of image you’re scanning from the Image pop-up
menu. The options are Color, Grayscale, Black and White, and Halftone.
Choosing Halftone opens a dialog box where you can choose a pattern for the
halftone screen. The patterns determine the shape and number of the dots
when the screen is created. Try different patterns to find the one that looks
best on your monitor or in a document you print.
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Destination Choose a destination for the image. The destination you specify is
used to determine the resolution at which the scanner will scan the image. For
example, if you select Monitor as the destination, the Resolution pop-up menu
automatically chooses the resolution that is correct for most monitors. You
can, however, change the resolution setting if you wish. You can also specify a
custom resolution. 

Resolution Choose the resolution you want to use. The resolution is
automatically set for the output device (destination) you’ve chosen, but you
can choose a different resolution if you wish. For more information on
resolution settings, see “Scanning With Custom Settings,” later in this chapter.

5 Click Preview.

The scanner creates a preliminary image in the preview area of the 
dialog box.

Tip: When the preview shows as much of the image as you want, you can
stop the scanner by pressing x-. (Command-period). 
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6 Drag to select the area you want.

A marquee (dashed line) surrounds the selected area. The Image Info area
changes to reflect the size of the selection. Image height, width, and size
change depending on the selection you make.

7 If you want to zoom in, click the zoom button (optional).

The area in the zoom view is the area that will be scanned. To return to the
original view, you must click Preview and start over.

8 Choose any automatic adjustments you may want the scanner to make.

Note: These adjustments take extra time and won’t work with all images.

Suggest Crop The scanner analyzes the picture for dominant shapes and crops
the image appropriately when the scan occurs.

Adjust Tone The scanner checks image brightness and contrast and adjusts for
them.

Straighten The scanner looks for the top and side edges of the image and
adjusts the orientation of the image when the scan occurs.
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9 Click Scan.

The scanner scans the original.

When the scan is complete, the image appears in a new document. The
document is named Image1. Subsequent scans in the same session are named
Image2, Image3, and so on.

Each dot on the scanned image corresponds to a pixel on the computer
screen. The higher the resolution (the greater the number of dots per inch),
the larger the image appears on the screen. So an image scanned at 75 dpi
appears smaller than one scanned at 300 dpi. To change the size of the image,
choose Zoom In or Zoom Out from the Image menu. 
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Saving a scanned image

As soon as the scanner has completed a scan, the new image, with the name
Image1, appears in a window on the Macintosh desktop, as shown at the end
of the previous topic. You can save the image with a more useful name, and in
a different folder, if you wish.

To save and rename a new image:

1 Make sure the image window is active.

To activate the document, click anywhere in the image window.

2 Choose Save from the File menu.

The Save dialog box opens.

3 Type a name in the Save Document box.

4 Choose a folder or disk drive for the file.

For more information on switching folders, see your Macintosh manual.
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5 Choose an image format from the File Format pop-up menu.

PICT (default setting): A widely used format that is compatible with most
Macintosh applications (uses ColorSync).

JPEG Joint Photographic Experts Group, a format that compresses files and
lets you choose compression versus quality.

Photoshop A format that supports all available Adobe Photoshop image
modes.

TIFF Tagged-Image File Format, a format used to exchange documents
between different computer systems (for example, between Macintosh and
Windows computers). This format is recommended when you scan text.

EPS Encapsulated PostScript™, a format supported by most illustration and
page-layout applications.

Windows BMP A format commonly used on MS-DOS and MS-Windows
computers.

GIF A format used on the Internet, GIF supports only 256 colors or grays.

6 Click Save.

The Macintosh stores the image in the folder you chose. 

When you next view the folder as an archive, this image and others in the
folder will appear as thumbnails—small representations of full-size images.
The thumbnails make it easy for you to identify the images you’ve scanned.
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Assigning a fax application to the Dispatcher

Before you can use the scanner for faxing, you must assign the driver for your
fax application to the Dispatcher. (If you have a fax modem or fax machine
connected to your computer, use the driver that came with it.) 

1 In the Dispatcher window, click the Fax drag-and-drop icon.

2 In the dialog box that appears, find the driver for your fax application. 

The Dispatcher takes you to the Extensions folder where your fax driver
should be.

Faxing or printing directly from the scanner

You can place a document on the scanner glass and send its image directly to
your fax application where you can then address and transmit the new image.
(If you have a fax modem or fax machine connected to your computer, use the
application that came with it.) Or, you can send the image to your printer. 

Example:  Sign or mark up an incoming fax that you’ve printed, scan the
marked-up original, and transmit the revised image to your fax application.

1 Put the original document on the scanner glass and close the scanner cover.

2 If necessary, start the OneScanner Dispatcher application by double-clicking its icon.

The Dispatcher window opens.

3 Click Scan Router.

4 In the Scan Router dialog box that appears, click an Image option to specify the type 
of image.
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5 Click Fax or Copy.

Printing (Copy):  The Print dialog box opens. Specify the number of copies
you want, set any other options, and click Print.

The original is scanned and sent to your fax application or currently 
chosen printer.

No image document created:  When you fax or print an image using the Scan
Router, an image document (file) is not created. The scanner simply sends
the new image to the fax application or printer. To fax or print the image
again, you must rescan it. 

Opening a saved image from an archive

Images you scan into the Macintosh using the Color OneScanner and
Dispatcher are stored in folders called archives. Archives contain images and
Hypertext Markup Language (HTML) files shown as thumbnails—little
sketches that represent full-size images.
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To open a saved image:

1 If necessary, start the OneScanner Dispatcher application to open the Dispatcher
window.

2 Click Archive.

A dialog box opens.

3 Select the name of the folder you want.

4 Click Select “folder name” (the large button at the bottom of the window). 

An archive opens, showing thumbnail representations of your images.

5 To open an image, double-click it.

You can use the image-editing tools and commands to modify the image or
select and copy parts of it. For information, see Chapter 5, “Editing Scanned
Images.”

Note: To open an HTML thumbnail from the archive, you must drag the
thumbnail to the drag-and-drop icon of an application that reads and supports
HTML files. Double-clicking the HTML thumbnail will not open it.
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Renaming a saved image in an archive 

To rename an image that is open:

1 Choose Save As from the File menu.

2 In the dialog box that appears, give the image a new name.

To rename an image in the Finder desktop

1 Click the icon to select the image and its name.

2 Type a new name.

Printing or faxing a saved image from an archive

You can use the drag-and-drop icons to send a saved image directly to your
printer or fax application.

To print or fax a stored image:

1 If necessary, open the Dispatcher window.

2 Click Archive and open the archive that contains the image you want to fax.

For instructions on opening archives, see “Opening a Saved Image From an
Archive,” earlier in this chapter. 
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3 Drag the thumbnail from the archive onto the Print or Fax icon.

Faxing If this is your first fax, a dialog box asks you to find your fax driver.
(For instructions, see “Assigning a Fax Application to the Dispatcher,” earlier
in this chapter.) If this is not your first fax, your fax application opens, ready
for you to address and transmit the scanned image.

Printing The Print dialog box opens. Set the options you want to use, and click
Print. (Make sure you have selected a printer in the Chooser before you try 
to print.)

The image is sent to the printer or fax application.
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Adding your own drag-and-drop applications

To speed up your work, you can add an application you frequently use to the
unassigned drag-and-drop icons. You can then send an image to the
application by dragging a saved image onto the icon and dropping it there.

Example:  You may routinely rework scanned images in the MacDraw® Pro
application. Ordinarily, you must scan an image, copy it, and paste it into a
MacDraw Pro document. With a MacDraw Pro drag-and-drop icon, you can
simply scan and save a series of images and then drag the thumbnails, one by
one, onto the icon. MacDraw Pro automatically opens the image in a new
document.

To add your own drag-and-drop application:

1 If necessary, open the Dispatcher window.

2 Click one of the icons labeled Unassigned.

A dialog box opens.
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3 Move through folders (and hard disks, if necessary) to find the application you want 
to add.

The application you select must support drag-and-drop behavior and must be
able to open documents in formats supported by the Dispatcher (such as
PICT and TIFF).

4 Double-click the application name, or select the name and click Select.

The dialog box closes. The application’s icon appears in the previously
unassigned icon. 

You can now use the icon to drag and drop scanned images. 
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Scanning directly into a graphics application

The OneScanner Dispatcher application comes with the Apple Color
OneScanner plug-in module. A plug-in is a software module that extends an
application for a specific purpose, such as importing scanned images. 

IMPORTANT If you haven’t already installed the Apple Color OneScanner plug-
in module, see “Installing the Plug-In Module for Use by Other Applications”
in Chapter 3. 

With the plug-in module and a compatible graphics application, you can scan
directly into a document without creating and saving an image with the
OneScanner Dispatcher application. 

Example:  You can use the Adobe Photoshop Acquire command to scan an
image directly into an Adobe Photoshop document. 

For information about installing and using the scanner plug-in module with
your graphics applications, see Chapter 3, “Installing the Scanner Software,”
and the manual for your graphics application.

Note:  The following steps are intended as a general example. Your
application may work differently.

1 Open the application you want to use.

2 Choose the application’s Acquire command.
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3 Choose Apple Color OneScanner (the plug-in module) as the source of the acquisition.

The Apple Color OneScanner dialog box opens. 

4 Click Preview, and change scanner options if necessary.

For information, see “Scanning with Automatic Settings,” earlier in 
this chapter. 

5 Click Scan.

The image is scanned and inserted in a new document for the application.
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Scanning with custom settings

After you’ve scanned a number of images, you may want to customize the
settings in the Apple Color OneScanner dialog box. This section provides
detailed information about settings for resolution, tone, and threshold.

Setting the resolution

The level of detail in a scanned image is determined by the number of dots
per inch (dpi) the scanner uses to reproduce an image. The number of dots
per inch defines the resolution. 

Higher resolutions provide more detail. Accordingly, the quality of a scanned
image increases with higher resolution—but not always. 

Things to think about when you set the resolution

Consider these factors when you choose a resolution:

m Each dot on the scanned image corresponds to a pixel on the computer
screen. The higher the resolution (the greater the number of dots per inch),
the larger the image appears on the screen. 

m As resolution increases, you need more memory and disk space to scan and
store the image on your hard disk drive. Sometimes the extra resolution
may not be worth the extra memory or disk space. 

m When you choose a resolution, check the Image Info area for image size
before you scan. 

m Scanning at a higher resolution may not necessarily produce better results
because the printer or other output device (such as a monitor) may not
reproduce the higher resolution. For example, a monitor may display an
image at 72 dpi, even though the image is at 600 dpi. In general, choose
the lowest dpi setting that will meet your needs.

m Large images take longer to print, and the quality of the printed version is
still limited by the capabilities of the printer.

m Large images take longer to scan, save, view, and manipulate.
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Recommended resolutions for maximum efficiency

The chart below shows the settings that Apple recommends for the output
devices listed. Keep in mind that an image scanned at a higher resolution will
require more memory and take longer to scan and print.

Recommended scanning resolutions

For this output device Set the scanning resolution at

Computer screen 75 dpi  

Laser printer, 300 dpi 100 dpi

Color laser printer, 600 dpi 150 dpi

Laser printer, 600 dpi 150 dpi

Linotronic imagesetter 200 to 300 dpi

Fax output device 75 dpi 

Inkjet printer 100 dpi
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Changing the tone (brightness and contrast)

You can improve the appearance of a scanned image by adjusting the tone
before you scan the image. Tone is a measure of brightness and contrast—the
intensity of blacks and whites, or colors, in a scanned image.

The way your monitor is set up affects the way an image appears on the
screen. For information, see your monitor manual.

Brightness

Brightness determines the overall lightness of a scanned image.

m With increased brightness, the scanned image generated by the scanner
will be lighter.

m With decreased brightness, the scanned image will be darker.

Contrast

Contrast is a measure of differences between light and dark tones.

m With increased contrast, all light tones become increasingly lighter, and all
dark tones become increasingly darker at the same rate.

m With decreased contrast, all light tones become increasingly darker, and all
dark tones become increasingly lighter at the same rate.

To change the tone of a scanned image:

1 In the Dispatcher window, click Scan to open the Apple Color OneScanner dialog box.

2 Click Preview.

3 Drag to select the portion of the image you want to scan.
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4 Click Tone.

The Tone dialog box appears.

5 Drag to select the portion of the preview you want to use as a sample for brightness 
and contrast. 

A solid outline appears around the selection. You can drag the outline to a
different part of the preview if you want to sample different areas. When you
release the mouse button, the selected area becomes the central point for 
tone variations. 

6 Select a sample from the Select a Range options.

Brightness From left to right, the tone variations show brightness from darker
to lighter.

Contrast From top to bottom, the variations show contrast from less to more.

When you click one of the variations, the preview changes and the variations
themselves are readjusted, using your recent selection as a new starting point.
The Fine Tune view changes to reflect your choice in the center panel,
outlined in red. 

7 To fine-tune the tone, drag the Brightness and Contrast sliders to change the settings.

The Fine Tune view shows the effects of any changes you make.
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8 To return to the Apple Color OneScanner dialog box, click Apply.

If you want to return the image to its original state, click Revert.

9 When the settings are the way you want them, click Scan.

The image is scanned using the settings you chose.

Changing the threshold

You can customize scanned images by resetting the threshold. Threshold is 
a measure of the darkest dark colors and the brightest light colors. In a 
black-and-white image, threshold is the point at which a dark color becomes
black and a light color becomes white.

To change the threshold:

1 In the Dispatcher window, click Scan to open the Apple Color OneScanner dialog box.

2 Click Preview.

3 Drag to select the portion of the image you want to scan.

4 Click Threshold.

The Threshold dialog box opens.
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5 In the Threshold dialog box, make the changes and selections you want.

m If you want the Dispatcher to recommend the appropriate threshold
settings, click Suggest.

m If you want to customize the threshold settings yourself, you can.

To set the lightest value, click the highlight dropper and then click the spot
in the original that you want to use as highlight threshold. The slider
adjusts to show the point you set, and the result adjusts to the change. The
point you set becomes the lightest color in the image. Colors lighter than
this point are reset to this level.

To set the darkest value, click the shadow dropper and then click the spot
in the original that you want to use as shadow threshold. The slider adjusts
to show the point you set, and the result adjusts to the change. The point
you set becomes the darkest point in the image. Colors darker than this
point are reset to this level.

Tip:  To work with a specific area of the image, click the zoom tool and then
click the area you want. Use the grabber to move the original image around if
necessary.
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6 To return to the Apple Color OneScanner dialog box, click Apply.

To return to the original settings, click Revert.

7 Click Scan.

The image is scanned with the settings you chose.

Changing image size and ruler units

The Apple Color OneScanner dialog box provides information about the size
of a scanned image and the size of the document (file) the image will occupy.

Viewing and changing image size (dimensions)

The Height and Width boxes show the size of the preview image or of the
selected area within the preview image. 

Dimensions are determined by 

m the size of the image area to be scanned

m the resolution setting

The minimum area you can scan is 48 by 32 pixels.

To specify the size of the scan:

m Type a value in the Height and Width boxes.

A marquee appears in the upper-left corner of the preview, scaled to the
size you typed. To select a different part of the image, move the pointer
inside the box formed by the marquee and drag the box where you want it.
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Viewing image file size

Image File Size shows how much memory, in kilobytes, the image file will
occupy. File size is determined by 

m the image type and resolution

m the size of the image area to be scanned

Changing the ruler units

You can set the ruler to use a different unit of measure for the height and
width of an image. You can set the ruler for inches, centimeters, pixels, points,
and picas.

To change ruler units:

m Choose the units you want from the Ruler Units pop-up menu.
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Ruler units pop-up menu
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Copyright regulations (USA)

It is illegal to reproduce certain official or copyrighted documents, and doing
so may be punishable by criminal or civil law. The following documents may
not be copied:

m currency

m government-issue securities and passports

m publicly or privately issued licenses or permits

m official documents

m private documents

In addition, it is unlawful to make copies of the following copyrighted works,
except for personal or household use or for other uses permitted under the
terms of the copyright:

m copyrighted publications

m music scores

m paintings

m prints

m maps

m drawings

m movies or photographs

m other copyrighted works
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You can use the OneScanner Dispatcher application to edit and improve the
appearance of scanned images. You can add and adjust colors, change the
size, crop an image, or copy selected areas to other documents.

This chapter tells you how to

m open a saved image and show the editing tools

m use the tools to edit your images

m change your view of a scanned image
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Opening a saved image

To open and edit a saved image, you first open the OneScanner Dispatcher
window and then open the image you want to edit.

To open the Dispatcher window:

1 Double-click the OneScanner Dispatcher icon.

The Dispatcher window opens.

2 Click Image Edit.

A dialog box opens.

62 Chapter  5

Download from Www.Somanuals.com. All Manuals Search And Download.



3 Open the folder that contains your saved images.

The first image is automatically selected. A preview appears on the left to
help you identify the image. Selecting another image name changes the
preview.

4 To open the image document, double-click an image name.

The document opens, and the tool, color, and brush palettes become
available. If you don’t see the tools, choose Show Tools, Show Brushes, or
Show Colors from the Window menu. 
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Image-editing overview

When you save a scanned image, the application stores it as an image
document. The image within the document is made up of pixels—the dots
that form any image on the computer screen. When you use the tools,
brushes, and color palette, you change the arrangement or appearance of 
the pixels.

Tool palette

Use the tools in the tool palette to select portions of the image, add text or
color, erase portions of the image, and do other tasks.

Brush palette

Use the brushes to set the shape for the painting tools. The brush shape you
choose affects the selected tool (spray can, paintbrush, clone, and smudge). 
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Selection rectangle

Grabber

Paint bucket

Eraser

Spray can

Clone

Background color

Lasso

Zoom

Text

Pencil

Paintbrush

Smudge

Foreground color

Note: To open the Macintosh Color Picker, click the 
foreground color (or Option-click the background color). 
You can use the Color Picker to design the colors you want.

Brush shapes
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Color palette

Use the color palette to change the color that you apply with the pencil,
brush, bucket, or spray can in the foreground, or to select the color that
appears when you use the eraser in the background.

To choose a paint color from an image: 

1 Select the pencil, brush, bucket, or spray can, press Option, and then click in the image.

The foreground indicator shows the color you clicked. You can drag the
eyedropper anywhere in the image, changing the foreground color as you go.

2 When you find the color you want, release the Option key. 

You can now use the pencil, brush, bucket, or spray can to apply the newly
chosen color. 

Showing and hiding the palettes

You can hide the palettes without quitting the application.

m To hide the palette, click the close box.

m To show a palette, choose Show Tools, Show Brushes, or Show Colors from the
Window menu.
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To change the color in the background when
you erase, Option-click the color you want. 

To change the color you apply in the
foreground, click the color you want.

Close box

To create custom colors, double-click a swatch. 
In the Color Picker that appears, select the color you want.
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Selecting images

When you select a portion of an image, you can move, cut, copy, or
manipulate the selection.

Regular shape

To select a rectangular part of an image:

1 Click the selection rectangle.

2 Drag the tool over an area to select that area.

The area you dragged over is surrounded by a marquee (a dashed line), which
indicates selection.

Marquee
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Irregular shape

To select an irregular shape:

1 Click the lasso.

2 Drag the lasso to trace an area around the shape you want to select.

When you release the mouse button, the marquee takes the irregular shape
you made.

Whole image

To select the whole image:

m Choose Select All from the Edit menu (or press x–A).

A marquee surrounds the whole image.

To deselect the whole image:

m Choose Deselect from the Edit menu. 
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Irregular marquee
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Using the tools to edit an image

Each tool on the tool palette has a special purpose: making a selection,
adding text, painting, and so on. 

Using a tool

To use a tool:

m Click the tool to make it active. 

Moving a selection

To move a selection around within the image:

m To drag the selection, use the tool you used to make it (the lasso or the selection
rectangle).
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The building was moved 
to cover the sheds.
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Zooming in

To zoom in close:

m Click the magnifying glass and then click a spot in the image.

The image is enlarged.

To zoom back out: 

m With the magnifying glass still selected, press Option and click the image.

You can also choose Zoom In or Zoom Out from the Image menu.

Filling a space with color

To fill a space with color:

1 Click the paint bucket.

2 Click a color on the color palette.

The foreground color changes to the color you clicked.

3 Click the space you want to fill.

The space fills with the foreground color. 
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Adding text

To type some text in the image:

1 Click the text tool.

2 Click the part of the image where you want to add text.

3 In the dialog box that appears, type the text you want.

You can also use the dialog box to choose the font you want, its size, style,
and color.

4 When you’ve got the text the way you want it, click OK.

The text appears in the image. 

Erasing a selection

To erase parts of the image:

1 Click the eraser.

2 Drag the eraser over the areas you want to erase.

The area you drag over fills with the background color. 

Note:  On 68000 series Macintosh computers, the eraser takes longer to work.
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The eraser tool was used to
create a black border.
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Drawing lines

To draw fine lines or shapes in the image:

1 Select the pencil.

2 Drag the pencil through the image to add the shapes or lines.

You can also zoom in and click individual pixels.

Tip:  To create a horizontal or vertical line, press Shift as you drag. To change
the size of the pencil line, use the brush palette.

Spray painting

To spray paint:

1 Select the spray can.

2 Drag the spray can across the image. 

The paint leaves a stroke in the foreground color.

Tip:  To change the size of the spray can stroke, use the brush palette.

Note:  On 68000 series Macintosh computers, the spray can takes longer 
to work.
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The spray can was
used to add

definition to the edges
of the petals.
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Painting with brushes

To paint with strokes of various sizes:

1 Select the brush.

2 Click one of the brush sizes on the brush palette.

3 Drag the brush to paint in the foreground color.

Cloning

A clone is a duplicate of a small part of an image. You can use the clone to
edit flaws in an image, painting it into an image at a different location. 

When you paint the clone back in, the painting starts at a reference point that
you define. This is easier to do than to explain, but here is an example.

Example:  Suppose you’ve scanned a picture of a building and you want to
cover a certain feature, such as a fountain, with another portion of the image,
such as a group of shrubs. You want to repeat the shrub portion of the image
without the sharp cut-out image of a copied-and-pasted selection. 

To clone an image and repeat it:

1 Click the clone tool.
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2 Press the Option key and then click the spot you want to serve as a reference point for
the clone.

In the example, you’d click a point in the shrubbery.

3 Move the clone tool over the point at which you want the image to begin repeating, then
start dragging.

In the example, you’d start dragging (painting) at a point somewhere near the
fountain. As you drag, the image begins to appear, starting with the reference
point.
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Option-click here (for example),
so you can clone the shrubbery
and cover up the fountain spray.

The reference point 
that is duplicated

The clone appears 
as you paint.
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As you extend the painting, the rest of the cloned image appears—or as much
of it as you want to paint.

Tip:  For a more natural appearance, reposition the reference point from time
to time. To do this, press the Option key and click the new spot you want to
clone.

Smudging

To smudge colors and lines into other colors and lines:

1 Select the smudge tool.

2 Drag through colors and lines.

The tool takes colors with it as you drag, much the same way your fingers
smear wet paint when you paint with your fingers. 
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Colors smear 
as you drag.
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Copying, cutting, or deleting a selection

You may want to copy part or all of an image and paste it into a word-
processing or desktop publishing document.

Copying within an image document

To copy and paste a selection within an image document:

1 Select the area you want to copy.

2 Choose Copy from the Edit menu (or press x–C).

3 Click anywhere in the image area and choose Paste from the Edit menu (or press x–V).

The copy is pasted where you clicked.

Copying and pasting into another application

To copy and paste a selection into a document in another application:

1 Select and copy a portion of an image as described in the previous steps.

2 If the other application is running and the document is open, click the document to
activate it.

You can open another application and create a new document without losing
the contents of the Clipboard. The copy you made remains on the Macintosh
Clipboard until you copy something else.

3 Set the insertion point in the document and choose Paste from the Edit menu 
(or press x–V).

The copy is pasted into the document.

Note:  Some publishing applications do not allow you to paste the selection.
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Cutting

To cut a selection from an image:

1 Select the area you want to cut.

2 To store a temporary copy of what you cut on the Clipboard, choose Cut from the Edit
menu (or press x–X).

3 To remove the selection without storing a temporary copy of it, press the Delete key.

This completely erases the selection. You cannot paste a copy elsewhere. 

Undoing an action

You can reverse an action if you do so before you take another action. For
example, if you press the Delete key to delete a selection, you can restore
what you cut if the cut was the most recent editing action you took.

To undo an action:

m Immediately choose Undo from the Edit menu (or press x–Z).

Zooming in and out

Sometimes you may need to work closely with an image or back away from it
to get an overview. A closer view makes it easier to work with details. A more
distant view makes it easier to work with an image as a whole.

To zoom into and out of an image:

1 Choose Zoom In or Zoom Out from the Image menu.

Zoom In Takes you closer to the image; elements of the image appear larger.

Zoom Out Takes you farther away from the image; elements of the image
appear smaller.

2 To return to a 100-percent view, choose Actual Size from the Image menu.

Changes you make with these commands don’t affect the size of the actual
image.
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Inverting an image from positive to negative

You can change a positive image to a negative image, or a negative image to a
positive image. 

To invert an image:

m Open the image and choose Invert from the Image menu. 

77Edi t ing Scanned Images

Download from Www.Somanuals.com. All Manuals Search And Download.



Adjusting the brightness and contrast

You can adjust the brightness and contrast of images. You may want to do this
when an image is too dark or does not show sharp enough differences
between dark and light colors.

To adjust brightness and contrast:

1 Choose Brightness/Contrast from the Image menu.

The Brightness/Contrast dialog box opens. 

2 Drag the sliders to the settings you want.

You can see the effects of the changes on the image.

3 Click Reset to return the settings to zero and leave the dialog box open.

4 Click OK to save the changes and close the dialog box.
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Changing the color balance

You can change the color balance in an image by adjusting color values for
shadows (darker areas), midtones, and highlights (brighter areas).

To adjust color balance:

1 Open the image you want to adjust.

2 Choose Color Balance from the Image menu.

The Color Balance dialog box opens.

3 Click Shadows, Midtones, or Highlights to specify the level of color you want to modify.

4 Drag a slider to adjust a color value.

The numeric values in the Red, Green, and Blue boxes change as you drag the
sliders for Cyan, Magenta, and Yellow. 

Example:  When you drag the Cyan slider toward the right, you increase Red
to a value between 1 and 100, and you decrease the Cyan value. When you
drag the Cyan slider toward the left, you reduce the Red value to a negative
number (from –1 to –100) and increase the Cyan value.

As soon as you adjust a color, the image is updated to show the change. 

5 To change your mind and return the image to its original color balance, click Reset.

The image reverts to the original color balance, but the dialog box remains
open.

6 Click OK to confirm your changes, or click Cancel to close the dialog box without
applying your changes.
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Option-click to change the 
background color.

Click a color to change the 
foreground color.
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Sharpening an image

You may notice that the edges of an image are softer than you want them to
be. Or, you may want to soften edges that look too sharp. 

To sharpen an image:

m Choose a command from the Sharpen submenu in the Image menu.

Commands in the Sharpen submenu add definition to an image. If an image
looks softer than you want it to look, the Sharpen commands may help. You
may not notice much difference on the screen.

A Little Has an almost imperceptible effect.

A Lot Has a significant effect.

Unsharp Masking Opens the Unsharp Masking dialog box:

Options in the Unsharp Masking dialog box adjust the contrast of image
details to create the illusion of a sharper image.
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Amount The amount determines what percentage of change will occur. The
default setting is 50 percent. Increase up to 100; decrease down to 1. A higher
percentage makes the effect stronger.

Radius The radius determines the depth of pixels that are affected at the edge
you’re changing. The default setting is 25 pixels. Increase up to 100; decrease
down to 0.1. A larger radius causes more of the pixels surrounding the edge
pixels to be sharpened.

Threshold Threshold determines the level of brightness to be used for
differentiation. The default setting is 0 levels. Increase up to 25. A lower value
produces a more pronounced effect.
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Threshold 0

Amount 75
Radius 75
Threshold 0

Amount 100
Radius 50
Threshold 1

Amount 100
Radius 100
Threshold 25
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Resizing an image

You can set a specific size for an image.

To resize:

1 Open the image and choose Resize from the Image menu.

The Resize dialog box opens.

2 Choose the units you want to use from the Units pop-up menu.

3 Type the new size and click OK.

The image is resized to fit your settings.
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Pop-up menu

To maintain the
image’s proportions
(aspect ratio), make
sure there’s an X in

this check box.
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Cropping an image

You can select an area of an image and then eliminate the surrounding area.

To crop an image:

1 Select the area you want to remain in the image.

2 Choose Crop from the Image menu.

The area around the selection is deleted.
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Flipping an image

Sometimes you may inadvertently scan an image upside down or on its side.
You can correct this situation by flipping the image.

To rotate a selection:

1 Open the image.

2 From the Image menu, choose an option from the Flip pop-up menu.

Vertical Flips the image vertically (upside down)

Horizontal Flips the image horizontally (from right to left)
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Original Flip vertical

Original Flip horizontal
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Rotating an image

1 From the Image menu, choose an option from the Rotate pop-up menu.

You can rotate the image 90 degrees left, 90 degrees right, or 180 degrees. You
can also choose Arbitrary rotation and set the number of degrees.

2 If you want to specify the degree of rotation, choose Arbitrary to open a dialog box.

3 Type the number of degrees you want and click OK.
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90˚ left rotation

Original 45˚ right rotation

90˚ right rotation 180˚ rotation
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Setting the image depth

You can change the number of colors used in an image or switch a color
image to black and white. You do this by changing the image depth. 

To change depth:

m From the Image menu, choose an option from the Image Depth submenu:

If you change the depth of an image to fewer colors or grays, you cannot
recover the original image depth. You must rescan the original to get back the
higher number of colors.
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Setting ColorSync preferences

Different devices—scanners, printers, and monitors, for example—reproduce
different ranges of colors. ColorSync is a color management system that
allows applications and device drivers to produce consistent color across
different devices.

ColorSync stores information about various devices in profiles. Profiles are
dictionaries that contain color information about a specific device. ColorSync
is an Apple system extension. You can switch ColorSync on and off and select
the appropriate ColorSync profile for your scanner when necessary.

To set ColorSync preferences:

1 With the OneScanner Dispatcher application open, choose ColorSync Preferences from
the Image menu.

The ColorSync Preferences dialog box opens.

2 To switch ColorSync on, click to place an X in the Use ColorSync box.

3 Choose the scanner model you want to use from the Use Scanner Profile pop-up menu.

If you are using the optional Transparent Media Adapter with the Color
OneScanner 1200/30, choose the ColorSync profile for the medium you are
scanning:

m Color OneScanner Flatbed for magazines, paper, other opaque originals

m Color OneScanner Positive for positive transparencies

m Color OneScanner Negative for negatives

Without the correct profile, you may not be satisfied with the resulting image
quality. If you change media, be sure to change the ColorSync profile.

4 Click OK to close the dialog box, or click Cancel to leave preferences the way they were. 
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An X in the checkbox
means ColorSync

is on.
Choose your model of the Color
OneScanner from this pop-up menu.
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Changing the way you view an archive

Occasionally you may want to view thumbnails in order by type, date, or size
rather than by name. 

To change the view:

1 Open the archive you want to look at.

2 From the Image menu, choose an option from the View By submenu: Name, Date, Type,
or Size.

The order of thumbnails in the archive changes to the option you chose.
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An optical character recognition (OCR) program such as Xerox TextBridge
analyzes scanned text and converts each character into a form of text a
computer can recognize. 

This chapter is a brief introduction to text scanning. You’ll learn

m how to scan a text document for use with the TextBridge application

m how to use the OneScanner Dispatcher application to send a saved text
image to the TextBridge application

Be sure you use the version of TextBridge that comes with your scanner. This
version has an OCR-to-HTML converter so you can save files in HTML
format.

89

6 Scanning Text

Xerox TextBridge application 
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Scanning a text document into the TextBridge application

You’ll find OCR scanning especially useful if you have many documents that
need to be moved onto the computer for storage or information-retrieval
(search) purposes. 

After the text is converted, you can copy and paste—or import—the text into
a word-processing or desktop publishing document. There you can edit and
revise the text without retyping.

To use TextBridge, you must complete two procedures:

m First install the TextBridge software, following instructions in the user’s
manual for TextBridge.

m Then you must assign TextBridge to the Dispatcher. For instructions, see
“Assigning the Xerox TextBridge 3.0H Application to the Dispatcher” in
Chapter 3 of this manual.

Optional Automatic Document Feeder:  An optional Automatic Document
Feeder is available from your authorized Apple dealer. This device increases
productivity by automatically feeding up to 20 pages into the scanner. If you
already have an Automatic Document Feeder, see Chapter 9, “Using the
Automatic Document Feeder,” for information on setup, use, and
maintenance.

To scan for OCR:

1 Put the text original on the scanner glass and close the scanner cover, or place the
originals in the document feeder.

2 If necessary, start the OneScanner Dispatcher application by double-clicking its icon.

The Dispatcher window opens:
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3 Click Scan to open the Apple Color OneScanner dialog box.

4 Choose Flatbed from the Source pop-up menu; if you’re using the document feeder,
choose Feeder.

5 Choose Black and White from the Image pop-up menu, and choose 300 dpi from the
Resolution pop-up menu. 

6 Click Scan.

The original document is scanned. 

7 Choose Save from the File menu.

The Save dialog box opens.

8 Choose TIFF from the File Format pop-up menu.

TIFF is the recommended format for text images. 

For information on saving an image and choosing a file format, see “Saving a
Scanned Image” in Chapter 4.

9 Click Save.

10 In the TIFF Options dialog box that appears, click Compressed.

When you’ve scanned a few pages, you can use the drag-and-drop OCR icon,
as described in the next topic, to send the text to TextBridge. 
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Moving a text image to the TextBridge application

After a text image is scanned, you can rename it or accept the automatically
numbered image. When you’ve scanned and saved an image, you can send the
image to the TextBridge application.

Note:  You can use TextBridge as a stand-alone application. It is not required
to use it through the Color OneScanner Dispatcher.

To send a saved text image to TextBridge:

1 If necessary, open the Dispatcher window.

2 Click Archive and open the archive that contains the image you want to send to the
TextBridge application.
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3 Drag the text thumbnail from the archive onto the TextBridge icon on the bottom panel of
the Dispatcher window.

The TextBridge dialog box opens.

4 Click Go.

5 See your TextBridge manual for information about the next steps.

In the TextBridge application, the image is converted to text. You can now
move the text into a word-processing, page-layout, or desktop publishing
document for editing.

93Scanning Text

Drag the text 
image to the 
TextBridge icon.

Download from Www.Somanuals.com. All Manuals Search And Download.



Converting a text image into an HTML document

When you’ve scanned and saved a text image (in TIFF or PICT format), you
can convert it to an HTML file for use on the Internet. 

1 If necessary, open the Dispatcher window.

2 Click Archive and open the archive that contains the image you want to convert to HTML.

3 Drag the thumbnail of the text image from the archive to the TextBridge drag-and-drop
icon.

This opens the TextBridge application.

4 In the TextBridge dialog box that appears, make the selections you want.

For an explanation of the features, see your TextBridge manual.

5 When the TextBridge settings are what you want, click Go.

Depending on what you chose in TextBridge, you may have to click a
Continue button one or more times to get to the next step.

6 In the “Add pages and continue” dialog box, select your document and click Continue.

7 In the Save Output As dialog box that appears, select a Dispatcher archive folder,
choose HTML from the Text pop-up menu, type a name for the file, and click Continue.

TextBridge optical character recognition converts the file to text and saves the
image in HTML format.

8 When you are finished converting images, quit the TextBridge application.

The document appears as an HTML thumbnail in the Dispatcher archive. You
can now drag and drop the HTML thumbnail to applications in the
Dispatcher that support and read HTML files, such as web-authoring
applications. 

Note:  TextBridge converts images to text and saves them as HTML files but
does not read HTML files.
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95

This chapter explains what happens when you choose any of the commands
in the OneScanner Dispatcher menus. The chapter

m provides a quick reference for advanced users

m shows dialog boxes opened by various commands and explains their
functions, but does not provide step-by-step instructions

The chapter is organized by menu.

7 Dispatcher Commands
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File menu

Commands in the File menu control activities at a document level. For
example, you use File menu commands to create and save documents and to
set up a document for printing.
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For information about 
opening images and 
archives, see Chapter 4, 
“Scanning Images.”
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New Scan

Opens the Apple Color OneScanner dialog box. 

New Image

Opens the New Image dialog box. You can specify a size, resolution, and
image depth for the new image.
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For information about
this dialog box, see

“Scanning with
Automatic Settings”
and “Scanning with
Custom Settings” in

Chapter 4.
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New Archive

Opens the New Archive dialog box. You can name the new archive and save it
in a folder of your choice.

Open Image

Opens a file dialog box where you can select and open a saved image. 

You use this dialog box to switch through folders and to find, select, and open
scanned images. 
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For information about
opening images, see
“Opening a Saved Image
From an Archive” in
Chapter 4.
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Open Archive

Opens a file dialog box where you can switch through folders to find, select,
and open the archive that contains the images you want. 

Scan Router

Opens the Scan Router dialog box, which gives you a choice between faxing
or printing (copying) the original document.

Text/Line Art Tells the scanner you are about to fax or copy an image.

Photograph Tells the scanner you are about to fax or copy a complex
photographic image.

Close

Puts away the active window. If you haven’t saved an image, or any changes
you’ve made, an alert box appears. You’re asked if you want to save the image
before you close it.

99Dispatcher  Commands

For information, see “Faxing 
or Printing Directly From the 
Scanner” in Chapter 4.

For information about 
opening an archive,
see “Opening a Saved 
Image From an Archive” 
in Chapter 4.
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Get Info

Opens a dialog box that provides detailed information about a selected image,
such as size, date created and modified, and image depth.

Save

Saves an image you’ve scanned, including any changes you have made to it.

If this is the first time you’ve saved the image, the Save As dialog box opens.
You can choose a file format for the image. The format you choose depends
on the requirements of the application into which you plan to import that
image.
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“Saving a Scanned Image” 
in Chapter 4.

Pop-up menu with file 
format choices
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Save As

Use the Save As command to save a document with a different name, in a
different folder, on a different disk, or in a different format—or all of the
above.

Revert

Returns a document to its last saved version. 

Page Setup

Opens the Page Setup dialog box (yours may look different):

Options in the Page Setup dialog box determine page size, orientation, and
other options before you print. 

Print
Opens the Print dialog box (yours may look different):

Options in the Print dialog box control how many copies to print, how many
pages and which pages, and other printing-related options—including color.
When you print photographic images, be sure to choose Color/Grayscale.
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For information about
page setup options,
see the manual that
came with your printer.

For information about
printer settings, see
the manual that came
with your printer.
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Print Archive View

Prints an archive, with thumbnails.

Quit

Ends a session with the OneScanner Dispatcher application. If you haven’t
saved any images now open, a message appears to ask you if you want to save
the image before you quit the application.

Edit menu

You use commands in the Edit menu to revise image documents by cutting,
copying, and pasting selected colors and shapes.

Undo (Redo)

Cancels or reapplies your most recent change to the scanned image (Undo).
For example, if you used the eraser tool and erased the wrong thing, you can
choose Undo to cancel the erasure. Redo restores the change you undid.

Cut

Removes the material you have selected and places it on the Clipboard.

Copy

Copies to the Clipboard the material you have selected. The original image
stays where it was when you selected it.
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For information about editing 
images, see Chapter 5, 
“Editing Scanned Images.”
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Paste

Copies the material on the Clipboard to the center of the document window
(where you can move it around as you wish). You can continue to paste copies
until you cut or copy a new selection (which replaces the contents of the
Clipboard).

Clear

In an image, removes the selection without placing it on the Clipboard. (The
contents of the Clipboard, if any, stay intact.) In an archive, Clear deletes a
selected image.

Select All (Deselect) 

Selects the whole image (Select All), or cancels a selection (Deselect).

Image menu

Commands in the Image menu control the way you view an image and the
way an image looks.
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Zoom In

Enlarges the image on the screen. Changes you make with this command
don’t affect the size of the printed image. You can also use the zoom tool.
Press Option to switch the tool between zooming in and zooming out. 

Zoom Out

Reduces the image on the screen. Changes you make with this command
don’t affect the size of the image when you print.

Actual Size

Returns the image to the standard view, a pixel-for-pixel representation,
neither enlarged nor reduced.

Invert

Creates a negative image from a positive image, or vice versa.

Brightness/Contrast

Opens the Brightness/Contrast dialog box. Options in the dialog box give you
more precise control of how bright or dark an image appears.

Color Balance

Opens the Color Balance dialog box, where you can adjust color values in a
saved image. For information, see “Changing the Color Balance” in 
Chapter 5.
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For more information, see 
“Adjusting the Brightness 
and Contrast” in Chapter 5.
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Sharpen

Opens a submenu you can use to change the definition of an image. If an
image looks too soft, use the Sharpen commands to adjust the image.

The Unsharp Masking command opens a dialog box:

Resize

Opens the Resize dialog box.

Crop

Cuts off parts of an image that are outside the selection marquee.
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For more information, see 
“Sharpening an Image” in 
Chapter 5.

For information about 
using this dialog box, see 
“Resizing an Image” in 
Chapter 5.
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Flip

Opens a submenu that gives you the choice of flipping the image vertically
(upside down) or horizontally (right to left). 

Rotate

Opens a submenu that gives you the choice of rotating an image 90 degrees
left, 90 degrees right, or 180 degrees. The Arbitrary command opens a 
dialog box.

Image Depth

Opens a submenu from which you can choose the number of colors you want
to use to view your images.

Effects

Once your Photoshop-compatible plug-in filters are installed in the Apple
Color OneScanner Plug-Ins folder, they appear in the Effects submenu and
can be applied to your images.
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For more information, 
see “Rotating an 
Image” in Chapter 5.

Download from Www.Somanuals.com. All Manuals Search And Download.



ColorSync Preferences

Opens the ColorSync Preferences dialog box.

The pop-up menu in this dialog box specifies the device used for ColorSync
settings. 

View By

Changes the way you see documents listed in an archive. You can view
documents by name, type, date, or size.

Window menu

You use commands in the Window menu to show and hide the Dispatcher
window and open images.

Hide (Show) Tools

Shows or hides the tool palette.
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Windows that are currently open

For information about using the tools, see 
Chapter 5, “Editing Scanned Images.”

An X in the checkbox
means ColorSync

is on.
Choose your model of the Color
OneScanner from this pop-up menu.
For more information, see “Setting
ColorSync Preferences” in Chapter 5.
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Hide (Show) Colors

Shows or hides the color palette.

Hide (Show) Brushes

Shows or hides the brush palette.

Dispatcher

Shows or hides the Dispatcher window.

Image-editing tools

Tool palette

The tool palette provides tools you use to edit scanned images.

Selection rectangle Selects a rectangular or square area so you can crop, copy,
cut, or clear the selection.

Lasso Selects an irregular portion of an image so you can copy, cut, or clear
the selection.

Grabber When an image is larger than its window (and the scroll bars are
active), you can use the grabber to move the image inside the window. 
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For information about using 
the tools to edit images, 
see Chapter 5, “Editing 
Scanned Images.”

Selection rectangle

Grabber

Paint bucket

Eraser

Spray can

Clone

Lasso

Zoom

Text

Pencil

Paintbrush

Smudge

Foreground color

Background color
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Zoom Gives you a closer or more distant view of an image.

Paint bucket Fills an area of the image with the foreground color.

Text Lets you add text to an image. 

Eraser Clears parts of an image when you drag the eraser over the image. The
color left by the eraser is the background color.

Pencil Adds individual dots to an image. If you drag the pencil across the
image, the dots appear to be a line. Zoom in to edit individual dots.

Spray can Applies soft strokes of paint in the shape of the brush you choose.

Paintbrush Applies the current foreground color when you drag the tool. You
can change the shape by clicking a different shape on the brush palette.

Clone Creates a duplicate of an image that you can paint elsewhere in the
same image or in another image.

Smudge Simulates the way you drag a finger through wet paint. 

Color palette

You use the color palette to change the foreground and background colors and
to create custom color swatches. For information, see “Image-Editing
Overview” in Chapter 5.

Brush palette

You use the brush palette to change the size of the painting tools (the pencil,
spray can, paintbrush, clone, and smudge tools).
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Colors available
Background color

Current
foreground color
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Your Apple Color OneScanner needs little maintenance, except for occasional
cleaning. Follow the guidelines in this chapter to keep the scanner working
properly.

Cleaning the scanner

To clean the scanner:

1 Switch off the scanner and computer.

2 Unplug the scanner power cord from the wall outlet.

3 Dampen a cloth with water or a mild cleaning agent, and then thoroughly wring out 
the cloth.

4 Use the cloth to gently wipe clean the document glass, the scanner cover, and exterior
surfaces.

WARNING Do not attempt to service the scanner yourself. Disassembling
the scanner can expose you to dangerous voltage points or other risks. If
you think your Apple Color OneScanner needs servicing, call your
authorized Apple reseller to find the service center nearest you.

8 Scanner Maintenance
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Don’t tip the scanner on its side or turn it upside down. To move the scanner,
follow the guidelines in “Carrying the Scanner” in Chapter 2.

5 Dry the damp areas with a clean, soft, dry cloth.

6 Use a clean, soft, dry cloth to remove any dust or debris from the power cord socket,
interface connectors, and other metal parts.

WARNING Avoid spraying cleaning agents or water directly on the
document glass. The spray could penetrate below the glass and
contaminate internal mirrors and lenses.

Never use a chemically treated cloth or cleaners that contain alcohol,
benzene, or ammonia. Use of such items can discolor, deform, or melt
the outside covering. Do not lubricate the scanner.
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The Apple Automatic Document Feeder is an optional accessory you can
purchase to automate the scanning of multiple original pages. You’ll find the
Automatic Document Feeder especially useful if you plan to use your scanner
for optical character recognition (OCR) or repetitive image retrieval work. 

This chapter shows you how to set up and use the document feeder. You’ll
find instructions for

m hardware setup

m loading of multiple original pages

m maintenance and troubleshooting

Setting up the Automatic Document Feeder

Setting up the Automatic Document Feeder is a simple process that requires
no special tools. After installation, the document feeder works as the top
cover of the scanner. If you find later that you don’t need the feeder, you can
easily remove it and replace it with the original scanner cover.

Set up the scanner first:  Before you connect the Automatic Document Feeder
to your scanner, you need to set up the Apple Color OneScanner and install
the scanner software. See Chapters 2 and 3 for instructions if you haven’t yet
set up the scanner hardware and software.

9 Using the Automatic Document Feeder
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To connect the document feeder:

1 Switch off the scanner and then switch off your Macintosh computer.

Devices connected through SCSI cables require a certain power-on sequence.
See “Switching the Power On,” in Chapter 2, for more information.

2 Grip the scanner top cover on both sides and lift it off.

Put the original cover away in a safe place for future use. The document
feeder replaces the cover.

Grasp cover here.

Power switch.
“O” is off and
“I” is on.
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3 Install the Automatic Document Feeder.

4 Close the document feeder by gently pushing it downward.

Insert the metal posts into the scanner.

115Using the Automat ic  Document  Feeder
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5 Remove the plastic cap from the port on the back of the scanner and put it in a 
safe place.

6 Plug the cable from the document feeder into the small port on the back of the scanner.

7 Switch on the scanner and then switch on your Macintosh.

The scanner makes some sounds as it warms up. After about 20 seconds, the
document feeder and scanner are ready to use. 

Automatic Document Feeder at a glance

Paper-height limit mark

Paper-size mark

Document tray

Document exit tray

Document guide

Document
feeder cover

Document
feeder
connector
cable Attachment brackets

Remove the
plastic cap.

Insert the
connector
cable.

116 Chapter  9

Download from Www.Somanuals.com. All Manuals Search And Download.



Choosing originals to scan

The document feeder is designed to accept standard office papers as
originals. Like a copy machine, the document feeder may have problems with
bent, torn, or otherwise mutilated originals.

These originals work best

The document feeder accepts paper with the following dimensions and
weight:

m paper size

length 10 1/8 to 14 in. (257 to 356 mm)

width 7 3/16 to 8 1/2 in. (182 to 216 mm)

m paper weight 16 to 20 lb. bond (60 to 160 g/m2)

These originals may cause trouble

The document feeder will not work well with

m originals with tears, perforations, or punch holes

m curled or wrinkled originals

m carbon-backed originals or originals on coarse paper

m labels or postcards

m thick, taped, or glued originals

Such originals will work fine if you place them directly onto the scanner,
rather than feeding them through the document feeder. 

Avoid valuable documents

Apple recommends that you avoid using the document feeder to scan valuable
originals. Some important documents, certificates, and photographs fall
within the acceptable limits for size and weight and can therefore go through
the document feeder for scanning. You should be aware that paper jams
sometimes occur, and such jams may damage a document. See “Bypassing the
Document Feeder,” later in this chapter, for information about scanning
without the feeder.
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Scanning with the document feeder

The document feeder significantly speeds up the scanning process, especially
if you’re doing optical character recognition (OCR) work. Partly because of
its speed, however, the document feeder has certain limitations of which you
should be aware:

m Do not scan images in color when you use the document feeder. The
images you get may not meet your quality requirements.

To scan several originals using the feeder:

1 Lift the document feeder and make sure no originals have been left on the scanner glass.

The document feeder will not work if an original is still on the glass.

2 Neatly stack the original pages face up on the document tray.

You can feed up to 20 sheets of 20-lb. bond (80 g/m2) paper.

3 Align the bottom left corner of the stack with the appropriate paper-size mark on the
document tray, as shown:

If you use legal-size paper, the ends of the sheets will extend over the end of
the tray.

Paper-size
marks

A4

LTR

B5
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4 Gently slide the document guide in the direction of the arrow, as shown, to align the
guide with the width of the originals.

5 Open the OneScanner Dispatcher if necessary.

Paper-height
limit mark

5/64 in.
(2 mm)

WARNING Do not stack the originals higher than the paper-height limit
mark (5/64 in./2 mm). Do not press down on the feeder. Do not place
anything heavier than 4.4 lb. (2 kg) on top of the document feeder.

Document guide
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6 Click Scan.

The Apple Color OneScanner dialog opens.

7 From the Source pop-up menu, choose Feeder.

8 From the Image pop-up menu, choose Black and White.

9 Click Scan.

The document feeder passes each original under the cover as it is being
scanned and then deposits the original in the document exit tray. The process
continues until all originals have been scanned.

If you’re scanning text, you can now use the drag-and-drop icon for
TextBridge to convert the scanned images to text.
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Choose
Feeder.

Choose
Black and
White.
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Bypassing the document feeder

As mentioned earlier in this chapter, certain originals may not work properly
with the document feeder. You may want to scan valuable documents that
could be damaged by the document feeder. You can do this by placing the
originals on the scanner glass rather than using the document feeder.

To bypass the document feeder:

1 Lift the document feeder as if it were the scanner cover.

2 Place the original on the glass.

3 Lower the document feeder over the original, if possible, so the document feeder is
closed during the scan.

4 Scan the original as usual.
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Clearing paper jams

If you scan only acceptable originals, you should have little trouble with
paper jams. For a review of factors that make originals acceptable, see
“Choosing Originals to Scan,” earlier in this chapter.

If a paper jam occurs while you’re using the document feeder, follow the
steps given in this section to clear the jam.

Follow the path

Clearing a paper jam is simple if you know where the jam occurs. Here is a
look at the path originals take as they move through the document feeder:

Document feeder cover Paper Document tray Document exit tray

Delivery guide sheetScanning lamp Image scanner
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Paper jams at the beginning of a scan

To clear a paper jam that occurs at the beginning of a scan:

1 Lift the document feeder cover, as shown, and remove the jammed paper.

2 Close the document feeder cover by placing your fingers on the center of the cover and
gently pressing down until the cover locks into place.

Document feeder cover

First, lift the document
feeder cover.

Then, carefully remove the
jammed paper.
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Paper jams at the end of a scan

To clear a paper jam that occurs at the end of a scan:

1 Lift the document feeder cover, as shown.

2 Lift the document tray and carefully remove the jammed paper, as shown.

First, lift the document tray.

Then, carefully remove the
jammed paper.

Document feeder cover
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3 Close the document tray.

4 Close the document feeder cover.

Document feeder cover

Document tray
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Paper jams inside the document feeder

To clear a paper jam that occurs inside the document feeder:

1 Lift the document feeder cover, as shown.

2 Lift the document tray to get to the jammed paper.

Document tray

Document feeder cover
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3 Press the two tabs (below) inward.

4 Open the flap, lower the delivery guide sheet, and carefully remove the jammed paper, 
as shown.

First, lower the
delivery guide sheet.

Then, remove
the jammed
paper.

Tab

Tab
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5 Reinsert the delivery guide sheet.

6 Close the document feeder and feeder cover.

Raise the delivery
guide sheet and insert
it under the plastic flap.

128 Chapter  9

Download from Www.Somanuals.com. All Manuals Search And Download.



Maintenance

With minimal maintenance, your document feeder will provide many years of
service. Follow these guidelines to keep the document feeder working
properly.

Cleaning the document feeder

To clean the document feeder:

1 If the document feeder is still attached to the scanner, turn off the scanner.

2 Disconnect the scanner’s power cord from the wall outlet.

3 Dampen a cloth with water or a mild cleaning agent, and then thoroughly wring out the
cloth.

4 Use the cloth to gently wipe clean the document feeder.

5 Dry the areas you cleaned with a clean, soft, dry cloth.

6 If the delivery guide sheet becomes dirty, or if vertical black lines appear on the scanned
image when you use the document feeder, gently wipe clean both surfaces of the
delivery guide sheet with a clean, soft, dry cloth.

For information about removing the delivery guide sheet, see the next topic.

WARNING Never use a chemically treated cloth or cleaners containing
alcohol, benzene, or ammonia. If you do, the outside covering can
become discolored or deformed, or it may melt.

WARNING Do not attempt to service the document feeder yourself. Refer
all servicing to an authorized Apple service center. For the location of
the center nearest you, please call your Apple reseller.
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Removing and replacing the delivery guide sheet

Your document feeder is equipped with a replaceable delivery guide sheet. If
the delivery guide sheet becomes extremely dirty or if it gets damaged, you
can purchase a replacement from your authorized Apple reseller.

To replace the delivery guide sheet:

1 Switch off the Macintosh and scanner.

2 Unplug the document feeder connector cable from the scanner.

Delivery guide sheet
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3 Remove the document feeder by grasping both sides of the document feeder cover and
lifting upward, as shown.

4 Turn the document feeder over so the bottom side—with the white plastic sheet—is
facing upward.
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5 Press the two tabs inward.

6 Open the flap and remove the delivery guide sheet, as shown.

Open the flap.

Remove the delivery guide sheet.

Tab

Tab
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7 Slide the new delivery guide sheet under the document feeder casing beneath the white
plastic cover.

8 Align the two holes in the delivery guide sheet with the pegs on the flap (as shown), and
close the flap.

9 Replace the document feeder on the scanner.

Peg Hole

New delivery guide sheet

Document
feeder casing

White plastic
cover

133Using the Automat ic  Document  Feeder

Download from Www.Somanuals.com. All Manuals Search And Download.



Removing and replacing the paper separator

Your document feeder is equipped with a replaceable paper separator, which
causes the document feeder to feed one original at a time. If the separator
repeatedly feeds more than one sheet, or fails to feed a sheet at all, you can
purchase a replacement from your authorized Apple reseller.

To replace the paper separator:

1 Position the document feeder so its front is facing you, and lift the document feeder
cover, as shown.

Document feeder cover
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2 Press the separator downward to unlock it, slide the separator toward you, and then lift
the separator straight up and out of the document feeder.
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3 Insert the new separator, and press it downward and then away from you.

Make sure that the separator is securely in place.

4 Close the document feeder cover.

Document feeder cover
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The Apple Transparent Media Adapter is an optional accessory you can
purchase to adapt your Apple Color OneScanner 1200/30 for overhead
transparencies and positive and negative film. (The adapter does not work
with the Color OneScanner 600/27.)

This chapter shows you how to set up and use the Transparent Media
Adapter. You’ll find instructions for

m hardware setup

m loading of transparencies or negatives

m maintenance and troubleshooting

Setting up the Transparent Media Adapter

Setting up the Transparent Media Adapter is a simple process that requires no
special tools. After installation, the adapter works as the top cover of the
scanner. If you find later that you don’t need the adapter, you can easily
remove it and replace it with the original scanner cover.

WARNING Handle the Transparent Media Adapter with great care. Marks
or scratches on the diffuser (the smooth surface on the underside of the
adapter) may appear in images scanned with the adapter. If scratches
impair image quality, the adapter must be replaced. Contact your
authorized Apple dealer.

10 Using the Transparent Media Adapter
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Set up the scanner first:  Before you connect the Transparent Media Adapter to
your scanner, you need to set up the Apple Color OneScanner and install the
scanner software. See Chapters 2 and 3 for instructions if you haven’t yet set
up the scanner hardware and software.

To connect the adapter:

1 Switch off the scanner and then switch off your Macintosh computer.

Devices connected through SCSI cables require a certain power-on and
power-off sequence. See “Switching the Power On,” in Chapter 2, for more
information.

2 Grip the scanner top cover on both sides and lift it off.

Put the original cover away in a safe place for future use. The adapter replaces
the cover.

Grasp cover here.

Power switch.
“O” is off and
“I” is on.
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3 Turn the Transparent Media Adapter over and unlock it.

Press the side of the switch that shows an open lock. 

4 Line up the transparent media alignment guide with the two holes at the back of 
the scanner.

The transparent media alignment guide comes in a separate package in the
box with the transparent media adapter.

Transparent media alignment guide

Press to
unlock

Diffuser
Be careful not to mark
or scratch this surface.
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5 Install the metal posts through the guide and into the holes.

6 Close the adapter.

Insert the metal posts through the
transparent media alignment guide
and into the scanner.
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7 Remove the plastic cap from the port on the back of the scanner and put it in a 
safe place.

8 Plug the cable from the adapter firmly into the small port on the back of the scanner.

9 Switch on the scanner and then switch on your Macintosh.

The scanner may make some sounds as it calibrates and warms up. After
about 20 seconds, the adapter and scanner are ready to use. 

Handling film

To protect your valuable film from fingerprints, grease, and so on, wear
gloves. Most photography supply stores sell gloves designed for handling film.

Remove the
plastic cap.

Insert the
connector
cable.
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Inserting film into a film guide for scanning

The adapter comes with three film guides that can hold these sizes:

m 35-mm film

m 60-mm film

m 4 x 5-inch film

IMPORTANT Be sure to insert negatives into the film guide so that no light
shows through at the sides of the negative film. You can allow a light gap at
the top and bottom of a negative, but light that shows at the sides may cause
the image to be overexposed. If you are scanning a negative that won’t fit any
of the film guides, create a mask for it from opaque materials to prevent light
from leaking through at the sides of the negative.

35-mm film guide

Tabs

Slots

60-mm film guide

4 x 5-inch film guide

Tabs

Tabs

Slots

Slots

Shutter strips
To avoid overexposure when scanning
negatives, always insert a shutter strip
in any slot that doesn’t contain film.

Shutter strip
When scanning negatives,
always insert a shutter strip in
any slot that doesn’t contain film.

Use this guide for 35-mm
mounted positives (slides).

With this film guide, you do not
need to use a shutter strip.You
can leave one of the film slots
empty or put film in both slots.
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To insert film into the film guide:

1 Place the film guide on a clean, flat surface.

Choose the guide that’s appropriate for the size of film or transparency you
intend to scan. 

2 Lift the tab and insert shutter strips into slots that will not have film in them.

IMPORTANT Shutter strips prevent overexposure (halation) of the scanned
images. If a strip of negatives is not long enough to fill the slot it’s in, that is
not a problem, but unused slots in the 35-mm and 60-mm film guides must
contain shutter strips. (The 4 x 5-inch film guide does not require a shutter
strip. You can leave one of the slots empty.) It is important not to allow any
gaps at the sides of the film. Light that shows through at the sides may cause
the film to be overexposed.

Shutter strips
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3 Lift the tab and insert negatives or positives for scanning.

Make sure the image is facing down. To avoid getting unwanted fingerprints
on the film, wear gloves designed for handling film.

4 Make sure the film is aligned properly in the slot.

Hold the film guide up to a source of light to check for openings where 
light leaks through. The edges of the film must be parallel to the edges of 
the slot. If you are scanning negatives, even a small gap that allows light
through perforations on the film can cause overexposure (halation) of the
scanned image.

Lift the tab and slide the
film into the guide. The
image should face down. Negative or positive film
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Scanning with the Transparent Media Adapter

To scan with the adapter:

1 Lift the adapter and make sure no originals have been left on the scanner glass.
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2 Place the film guide (with film and shutters in place) on the scanner bed.

Be careful not to obstruct the light correction zone (the gap between the top
of the film guide and the transparent media alignment guide).

Note: To scan positive film that is too large for any of the film guides, place
the film on the document glass, leaving space for the light correction zone. To
scan negative film, create a mask from opaque material to prevent light leaks.

Transparent media
alignment guide

Light correction zone

Top of film guide

Slide the film guide
under the left-hand
edge of the scan bed.

Line up the arrow on
the film guide with the
arrow on the scanner.
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3 Close the Transparent Media Adapter.

You are ready to scan your image.

4 If necessary, open the OneScanner Dispatcher.

5 Click Scan.

The Apple Color OneScanner dialog box opens.
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appropriate
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6 From the Source pop-up menu, choose Transparency.

7 In the dialog box that appears, select the type of film you are scanning.

Each film type named in the Negative pop-up menu belongs to one of four
negative film bases. If you don’t see your film named in the menu, try each of
the four bases for scanning your negative. Then use the one you like best. The
bases to try are:

m Agfa Optima 400

m Agfa XRS

m Kodak Ektapress

m Kodak Ektar

8 Click OK.

9 Click Scan.

The scanner scans the film. If you are scanning negatives, the scanner takes
extra time for calibration.

Bypassing the adapter

Even though you have the Transparent Media Adapter on your scanner, you
can still scan paper originals. Place the originals on the document glass. In
the Dispatcher window, choose Flatbed from the Source pop-up menu. Then
preview or scan as usual. Be careful not to scratch the diffuser with staples or
paper clips attached to paper originals. Scratches are permanent and may
show up as flaws in the images you scan from film.
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Maintenance

With minimal maintenance, your adapter will provide many years of service.
Follow these guidelines to keep the adapter working properly.

Cleaning the exterior of the adapter

To clean the adapter:

1 If the adapter is still attached to the scanner, turn off the scanner.

2 Disconnect the scanner’s power cord from the wall outlet.

3 Dampen a cloth with water or a mild cleaning agent, and then thoroughly wring out the
cloth.

4 Use the cloth to gently wipe clean the adapter.

5 Dry the areas you cleaned with a clean, soft, dry cloth.

WARNING Never use a chemically treated cloth or cleaners containing
alcohol, benzene, or ammonia. If you do, the outside covering can
become discolored or deformed, or it may melt.

WARNING Do not attempt to service the adapter yourself. Refer all
servicing to an authorized Apple service center. For the location of the
center nearest you, please call your Apple reseller.
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Cleaning the diffuser

The diffuser is the inside surface of the adapter through which light is
transmitted. Dirt or scratches on its surface may discolor or distort scanned
images. 

To clean the diffuser:

1 Open the adapter and let its hinges hold it open.

2 Lightly wipe the dirt off the diffuser with a dry, soft cloth.

Troubleshooting

The lamp doesn’t light, or it lights but doesn’t move.

m The cable from the adapter may not be properly plugged into the port on
the back of the scanner. 

Make sure the cable is plugged in firmly.

m The light correction zone may be blocked. 

Be sure to leave an unobstructed .59-inch (15-mm) space at the top of the
document glass. For more information about the light correction zone, see
“Scanning With the Transparent Media Adapter,” earlier in this chapter.

The quality of the scanned image is poor.

m The film may not be positioned correctly. 

Load the film into a film guide. Make sure the film is straight in the slot.
Make sure the lid is closed.

WARNING Do not press or rub hard as you wipe the diffuser. This might
scratch the surface. Never use a chemically treated cloth or cleaners
containing alcohol, benzene, or ammonia. If you do, the surface of the
diffuser may be discolored, deformed, or even dissolve.
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The image is reversed.

m The film is facing the wrong way. 

Make sure the film is face down.

Color quality is unsatisfactory.

m All or part of the light correction zone has been obstructed. 

If the film is in a film guide, make sure the guide is positioned properly.
See “Inserting Film Into a Film Guide for Scanning,” earlier in this chapter.

If you’re not using a film guide for positives, be sure to allow at least .59
inch (15-mm) of space between the top edge of the film and the top edge of
the document glass. (The space comprises the necessary light correction
zone.) 

If you’re not using a film guide for negatives, be sure to allow space for the
light correction zone. In addition, be sure to mask the sides of your
negatives to avoid overexposure (halation). Use a black opaque material for
masking (something similar to the material in the film guides).

m You may have selected an inappropriate negative film type, producing
incorrect colors.

Choose the correct film type. For details, see “Scanning With the Adapter,”
earlier in this chapter.

m You may not have selected an appropriate ColorSync profile for the
medium you are scanning.

m Color OneScanner Flatbed for magazines, paper, other opaque originals

m Color OneScanner Positive for positive transparencies

m Color OneScanner Negative for negatives

Every time you change from one medium to another, you must select the
correct ColorSync profile. Choose ColorSync Preferences from the Image
menu. In the dialog box that appears, select the profile you want.
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An irregular blotch or line consistently appears in the same place in scanned images.

m The diffuser may be dirty. 

Carefully wipe the diffuser with a clean, soft, dry cloth. See
“Maintenance,” earlier in this chapter.

m There may be a scratch or other mark on the diffuser. 

Contact an authorized Apple service center. For the location of the center
nearest you, please call your Apple reseller.  

m The film or transparency may be dirty. 

Carefully wipe the film with a clean, soft, dry cloth. 

m There may be a scratch or other mark on the film or transparency. 

Replace the film with a copy that has not been scratched or marked.

The edge of an image is dark.

m The adapter may not be securely shut.

Make sure the adapter is closed before you scan.

Scanned images from negatives contain faded or whitened areas.

m Gaps around the edge of the negative film can allow overexposure
(halation) to occur.

Make sure the film and the shutter strips are correctly positioned in the
film guide. For details, see “Inserting Film Into a Film Guide for
Scanning,” earlier in this chapter. If necessary, you can use black paper (or
any opaque paper) to mask the gaps.

You see a striped or moiré pattern on a scanned image.

m Moisture on the film or the document glass causes the film to stick to 
the glass.

Use a soft, clean, dry cloth to wipe the moisture (or oil) from the diffuser,
the film, or the document glass.
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Physical
m Length 16 in. (406 mm)

m Width 11-1/8 in. (283 mm)

m Height 3-1/8 in. (79 mm)

m Weight About 13.2 lb. (6 kg)

Technical
m Scanner type Flatbed

m Scanning element Charge-coupled device (CCD) image sensor

m Resolution 60 to 2400 dpi (Apple Color OneScanner 600/27)

60 to 4800 dpi (Apple Color OneScanner 1200/30)

m Bit depth 27 (Apple Color OneScanner 600/27) 9, 9, 9 is RGB

30 (Apple Color OneScanner 1200/30) 10, 10, 10 is 
RGB

m Maximum 8.5 by 11.7 in. (216 by 297 mm)
document size 8.5 by 14 in. (216 by 355.6 mm) with optional

Automatic Document Feeder
8 by 10.8 in. (203.2 by 274 mm) with optional
Transparent Media Adapter

m Interface SCSI II

Appendix A
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m Other functions RGB masking (color only)

Window (scan area) selection, negative/positive
reversal, X–Y scaling, mirror image

m Options Automatic Document Feeder

Transparent Media Adapter

Environmental

Noise (maximum)

m Scanning <55 dB

Operating temperature

m Without the document feeder, with or without the Transparent Media Adapter
Ambient temperature:  41 to 95° F (5 to 35° C)
Relative humidity:  15 to 85 percent

m With the document feeder
Ambient temperature:  50 to 90.5° F (10 to 32.5° C)
Relative humidity:  20 to 80 percent

Power requirements 
m Power supply AC input:  100-240 V 

+/– 10 percent, 48 to 62 H

m Power consumption 35 W maximum
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In general, as long as you follow the maintenance and safety instructions
provided in this manual, you should have few problems with your scanner.
This chapter provides solutions to some problems that you might encounter.

IMPORTANT If you have a problem with your scanner and nothing
recommended here solves it, contact your authorized Apple service center. 

Note: If you have the optional Transparent Media Adapter on your scanner,
you should also see the troubleshooting section in Chapter 10.

Scanning and hardware problems

The scanner icon has an “X” across it when I start up my Macintosh.

m The scanner may be off. 

Make sure the scanner is plugged in and that the power light is on.

m You may have turned on the power in the wrong sequence. 

Always switch on the scanner before you switch on the Macintosh. Shut
down the Macintosh, switch the scanner on, wait about 20 seconds, and
restart the Macintosh. 

m The SCSI ID number or termination may be incorrectly set. 

Check the setting for the SCSI switch on the back of the scanner. For
information, see Chapter 2, “Setting Up the Scanner.”
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m The SCSI connection may not be secure. 

Make sure the SCSI cable between the scanner and the Macintosh is
securely fastened. If the scanner is part of a SCSI chain, check all the 
SCSI cables.

When I try to scan, I get a message that says, “The application can’t find the scanner.”

m You may not have properly installed the scanner software. 

Review Chapter 3, “Installing the Scanner Software,” and then reinstall 
the software.

m You might have a conflict between the Apple Color OneScanner driver and
another system extension. 

See your Macintosh user’s manual or Macintosh Guide, Apple’s online help
system, for information about resolving system conflicts.

m The scanner may not be on. 

Check the power light. If it’s off, shut down the Macintosh, switch the
scanner on, and then restart the Macintosh.

m The SCSI ID number or termination may be incorrectly set. 

Check the setting for the SCSI switch on the back of the scanner. See
Chapter 2, “Setting Up the Scanner.”

Everything on my monitor screen is frozen.

m Your system is hung. 

Turn the scanner off, wait ten seconds, and turn it on again. Then restart
your Macintosh. 

When I switch the scanner on, its power light goes on briefly and then goes off.

m The power cord may be loose. 

Make sure the power cord is securely inserted in a grounded three-pin
power outlet. If plugging the cord in doesn’t solve the problem, you 
may have a serious hardware problem. See your authorized Apple 
service center.
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The scanner makes strange noises when I try to scan, and no image is produced. 

m The scanner carriage may be locked.

Make sure the scanner lock is in the unlocked position. For information,
see “Locking and Unlocking the Scanner” in Chapter 2.

I still have my old Apple OneScanner attached to my Macintosh. When I try to scan with
the OneScanner Dispatcher application, a message tells me the application can’t find the
new scanner.

m You may need to reset the SCSI ID number for the new scanner. 

Assign a SCSI ID number to the new scanner that is lower than the ID
number assigned to the old scanner. For information, see Chapter 2,
“Setting Up the Scanner.”

Or, turn off the old scanner or remove it from the SCSI chain.

Something inside the scanner rattles when I move the scanner.

m The scanner’s internal hardware may have been damaged.

You may have a serious hardware problem. See your authorized Apple
service center.

I keep getting messages that there’s not enough space on my hard disk.

m You may need a larger hard disk. 

Try these memory-saving options:

m Try scanning at a lower resolution so less space is needed.

m Try cropping the image before you scan. A smaller image requires 
less space.

m Try switching to Black and White or Grayscale when you scan. Images
scanned with these options require less space than images scanned 
in color.
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Image quality problems

My images have smudges and smears all over them.

m The scanner glass and the scanner cover may need cleaning.

Use a clean, soft, damp cloth to wipe the glass and cover clean.

Scanned images have consistent vertical streaks through them, even though I’ve
cleaned the scanner glass.

m You may have a hardware problem.

See your authorized Apple service center.

My scanned images are of generally poor quality.

m You may be letting too much light in.

Make sure the scanner cover is closed when you scan.

Problems with the Automatic Document Feeder

When I try to use the Automatic Document Feeder, the Feeder command in the Source
pop-up menu is dimmed and unavailable.

m The small cable that connects the document feeder to the scanner may
have come loose. 

Switch off the scanner and your Macintosh and connect the cable. Switch
the scanner on again, wait about 20 seconds, and then switch on your
Macintosh.

My Automatic Document Feeder is not feeding originals when I try to scan them.

m You may not have set the software source correctly.

Make sure you’ve selected Feeder in the Source pop-up menu of the Apple
Color OneScanner dialog box.

m The document feeder may not be able to find the originals.

Make sure you’ve placed the originals in the input tray.

I get a message that says the computer can’t see the document feeder.

m You may not have set the software source correctly.

Make sure you’ve selected Feeder in the Source pop-up menu of the Apple
Color OneScanner dialog box.
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This appendix shows you how to connect a chain of devices to your
Macintosh computer. 

IMPORTANT If the scanner is the only SCSI device you plan to connect to your
computer, do not use the instructions in this appendix. Instead, see Chapter 2,
“Setting Up the Scanner,” where you’ll find the information you need. 

About SCSI ID numbers

Your Macintosh has an external SCSI port that accepts a SCSI cable. You use
this port to connect a device, such as the scanner. 

Your computer may also have a second, internal SCSI connection. The
computer’s internal hard disk drive is connected to this. If your computer
came with a CD-ROM drive, the drive is also attached to the internal 
SCSI interface.

Each device has a unique ID number

To keep everything straight, the Macintosh requires that each SCSI device be
assigned a SCSI ID number. This SCSI ID number is 

m set by a hardware switch in each device

m tracked by the system software
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For example, the internal hard disk drive is, by convention, always assigned
SCSI ID 0 (internal). The system software shows the hard disk at that
location.

You can connect a total of seven internal and external SCSI devices to the
Macintosh. Each device must have its own unique SCSI ID number, from 0 to
6 (or from 1 to 6 if you have an internal hard disk drive installed).

About ID numbers:  Do not assign numbers 0 or 7 to the scanner. The default
setting for the internal hard disk drive is 0, and for the computer, 7. Make sure
you use a number that is not assigned to any other SCSI device because each
ID number must be unique.

Factory setting

The SCSI ID number for the Apple Color OneScanner is set in the factory at
2, with termination on (see the next section), but you can change the setting 
if necessary.

About SCSI termination

To ensure accurate transmission of information, a terminator is used at the
end of a SCSI chain, even if there is only one device in the chain. 

Any Macintosh computer with an internal hard disk drive contains its own
terminator. This means that you need only one other terminator (internal or
external) attached to the last device in the chain. 

The Apple Color OneScanner has an internal (built-in) terminator. This
control switch can be set to various SCSI ID numbers. Each number can be
set with termination on or off. 

m With termination on, information stops at the scanner. 

m With termination off, information can pass through the scanner and travel
onward down a chain to another SCSI device.
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Factory setting

The internal terminator for the Apple Color OneScanner is set to “on,” but
you can change it.

Note:  You need an external terminator with the scanner only if you have a
Macintosh IIfx or PowerBook computer. The Macintosh IIfx requires a
special terminator. Make sure you purchase the appropriate item if you need
an external SCSI terminator.

Connecting the SCSI devices

The illustrations later in this appendix show various SCSI arrangements and
show where termination is required. Use the illustrations for reference as you
set up a SCSI chain.

To connect your SCSI devices to your Macintosh computer:

1 Turn off the computer and any SCSI devices, but leave the power cords plugged into
grounded outlets. 

2 Touch any of the metal connectors on the back of your Macintosh. 

This safely discharges static electricity that may be on your clothes or body.

3 Attach the small end of the system cable to the SCSI port on the Macintosh. 

4 Attach the large end of the system cable to either SCSI port on the back of one of the
devices in your SCSI chain.

WARNING Make sure your computer and all SCSI devices are turned off.
If either the computer or any of the devices remains on, you could
damage the computer or the device.
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5 Attach either end of a SCSI peripheral cable to the other port on the back of the 
first device.

If you want the second device to be more than 18 inches away from the first,
connect a cable extender to the end of the SCSI peripheral cable. You can use
up to 20 feet (6.1 meters) of cables.

6 Attach the other end of the SCSI peripheral cable (or the other end of the cable extender)
to either SCSI port on the back of the second device.

7 Repeat steps 5 and 6 for each additional SCSI device you want to connect.

8 Attach the cable terminator (if you need one) to the remaining SCSI port on the back of
the last SCSI device in your chain.

IMPORTANT Most external SCSI devices from Apple do not have internal
terminators, but the Apple Color OneScanner has a built-in terminator. To
make certain about other devices, check their manuals.

Assembling the SCSI chain

The illustrations on the next few pages show the various SCSI configurations
and the cables and termination settings required.
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163Assembl ing a SCSI Chain

The scanner is connected directly to the Macintosh.
No other external SCSI devices are set up.

All Macintosh computers except Macintosh IIfx and PowerBook Scanner Termination

m No external SCSI terminator is needed.

m Use factory setting (SCSI ID number 2,
termination on); no change is required.

m You can change the scanner ID number if
you need to, but set termination on.

Scanner is the only device connected to the Macintosh

Scanner connects directly to 
Macintosh with SCSI system cable.

Macintosh

Scanner

Macintosh IIfx only Scanner Termination

m Use special Apple Macintosh IIfx terminator
between large end of system cable and
scanner.

m Set scanner SCSI ID to number 2,
termination off.

m You can change the scanner ID number if
you need to, but set termination off.

Macintosh PowerBook only Scanner Termination

m Use external terminator between large end of
system cable and scanner.

m Set scanner SCSI ID to number 2,
termination on.

m You can change the scanner ID number if
you need to, but set termination on.

IIfx terminator

Macintosh IIfx

Scanner Scanner connects directly to Macintosh 
with SCSI system cable and terminator.

Terminator

Scanner Scanner connects directly to Macintosh 
with SCSI system cable and terminator.

Macintosh
PowerBook
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Macintosh PowerBook only Scanner Termination

m Use external terminator.

m Use factory setting (SCSI ID number 2,
termination on); no change is required.

m You can change the scanner ID number if
you need to, but leave termination on.

The scanner is at the outside end of a SCSI chain.
Other external SCSI devices are set up between the scanner and the Macintosh.

All Macintosh computers except Macintosh IIfx and PowerBook Scanner Termination

m No external SCSI terminator is needed.

m Use factory setting (SCSI ID number 2,
termination on); no change is required.

m You can change the scanner ID number if
you need to, but leave termination on.

Scanner is at the end of the SCSI chain

Macintosh IIfx only Scanner Termination

m Use special Apple Macintosh IIfx terminator.

m Use factory setting (SCSI ID number 2,
termination off); no change is required.

m You can change the scanner ID number if
you need to, but turn termination off.

 SCSI peripheral cable SCSI system cable

Macintosh

SCSI 1
device

SCSI 2
device

SCSI 3
device

Scanner

IIfx terminator

SCSI 1
device

SCSI 2
device

SCSI 3
device Scanner

Macintosh IIfx

SCSI peripheral cableSCSI system cable

SCSI 2
device

SCSI 3
device Scanner

Macintosh
PowerBook

SCSI system cable SCSI peripheral cable

Terminator
SCSI 1
device
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The scanner is connected directly to the Macintosh.
Other external SCSI devices are set up beyond the scanner.

All Macintosh computers except Macintosh IIfx and PowerBook Scanner Termination

m A SCSI terminator is needed on last 
device in chain.

m Set scanner SCSI ID to number 2, 
termination off.

m You can change the scanner ID number 
if you need to, but set termination off.

Macintosh PowerBook only Scanner Termination

m No external terminator needed for scanner.

m Set scanner SCSI ID to number 2, 
termination on.

m You can change the scanner ID number 
if you need to, but set termination on.

Scanner is at the beginning of the SCSI chain

Macintosh IIfx only Scanner Termination

m Use special Apple Macintosh IIfx terminator
on last device in chain.

m Set scanner SCSI ID to number 2, 
termination off.

m You can change the scanner ID number if
you need to, but set termination off.

Macintosh

Scanner

SCSI peripheral cableSCSI system cable

SCSI 1
device

SCSI 2
device

Terminator

IIfx terminator

Macintosh IIfx

Scanner

SCSI  system cable SCSI  peripheral cable

SCSI 1
device

SCSI 2
device

Scanner

SCSI  system cable SCSI peripheral cable

SCSI 1
device

SCSI 2
device

Macintosh
PowerBook

Terminator
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The scanner is in the middle of a SCSI chain.
The scanner is between two other external SCSI devices.

All Macintosh computers except Macintosh IIfx and PowerBook Scanner Termination

m A SCSI terminator is needed on last device
in chain.

m Set scanner SCSI ID to number 2,
termination off.

m You can change the scanner ID number 
if you need to, but set termination off.

Scanner is in the middle of the SCSI chain

Macintosh IIfx only Scanner Termination

m Use special Apple Macintosh IIfx SCSI
terminator on last device in chain.

m Set scanner SCSI ID to number 2,
termination off.

m You can change the scanner ID number 
if you need to, but leave termination off.

Macintosh PowerBook only Scanner Termination

m Terminator needed at start and end of 
SCSI chain.

m Set scanner SCSI ID to number 2,
termination off.

m You can change the scanner ID number 
if you need to, but leave termination off.

Scanner

SCSI system cable SCSI peripheral cable

SCSI system cable

SCSI 1
device

SCSI 2
device

Macintosh
PowerBook

Terminator

Terminator

Macintosh

ScannerSCSI 1
device

SCSI system cable SCSI peripheral cable

SCSI system cable

Terminator

SCSI 2
device

IIfx terminator

Macintosh IIfx

Scanner

SCSI system cable SCSI peripheral cable

SCSI system cable

SCSI 1
device

SCSI 2
device
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A

accessory kit, unpacking  6
Actual Size command (Image menu)  104
Agfa Optima 400 135-24 film  148
Agfa XRS film  148
alias, using to install plug-in module  22
aligning originals  29
Apple Color OneScanner dialog box  36,

50, 147
controls not visible  36

Apple Color OneScanner plug-in module.
See also scanner

installing  22–23
using with graphics applications

49–50
Apple OneScanner Dispatcher

application, installing  19–22
Apple service centers  149
applications

adding to drag-and-drop icons  47–48
can’t find scanner  156
installing Apple OneScanner

Dispatcher  19–22
using plug-in modules  22–23, 26

Archive button (Dispatcher window)  33
archives  43–44

viewing  88
art, specifying type  42

assembling, SCSI chain  162–166
Automatic Document Feeder

acceptable originals  117
bypassing  121
clearing jams  123–128
connector  10
diagram  116
indicating source of scan  36
maintenance  129–136
obtaining  90
problems  158
scanning multiple originals  118–120
setting up  113–116
troubleshooting  158

B

background color, changing  64, 109
background tool (tool palette)  64
backup disks  20
Black and White image option  36
black lines on image  129
books

aligning  30
scanning  28

Brightness/Contrast command (Image
menu)  104

brightness level  53–54, 78, 104
brush palette, image-editing tools  64, 109

167

Index
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C

cable
connecting and disconnecting  13–14
connecting Transparent Media

Adapter  141
SCSI  6, 7
terminator  13

carriage, unlocking  11
characters, converting to recognizable

text  89
cleaning

Automatic Document Feeder  129
scanner  111–112
Transparent Media Adapter  149–150

Clear command (Edit menu)  103
clearing paper jams  123–128
clips, retaining  14
clone tool (tool palette)  64, 109
cloning an image  72–74
Close command (File menu)  99
color

adding  64
art  42
available  109
balance  79
changing  65
image option  36
maintaining consistency  20, 25
palette for editing  65, 109
reproducing consistently  87
resetting values  55–56
space  69
using Transparent Media Adapter  151

color art, sending from scanner  42–43
color images, scanning in document

feeder  118
ColorSync Preferences command (Image

menu)  107
ColorSync Preferences dialog box  87
ColorSync system program  20

setting preferences  87
setting up  25

commands (Dispatcher)
Actual Size (Image menu)  104
Brightness/Contrast (Image menu)  104
Clear (Edit menu)  103
Close command (File menu)  99
ColorSync Preferences (Image 

menu)  107
Copy (Edit menu)  102
Crop (Image menu)  105
Cut (Edit menu)  102
Dispatcher (Window menu)  108
Effects (Image menu)  106
Flip (Image menu)  106
Get Info (File menu)  100
Hide (Show) Brushes (Window 

menu)  108
Hide (Show) Colors (Window 

menu)  108
Hide (Show) Tools (Window 

menu)  107
Image Depth (Image menu)  106
Invert (Image menu)  104
New Archive (File menu)  98
New Image (File menu)  97
New Scan (File menu)  97
Open Archive (File menu)  99
Open Image (File menu)  98
Page Setup (File menu)  101
Paste (Edit menu)  103
Print (File menu)  101
Print Archive View (File menu)  102
Quit (File menu)  102
Resize (Image menu)  105
Revert (File menu)  101
Rotate (Image menu)  106
Save (File menu)  100
Save As (File menu)  101
Scan Router (File Menu)  99
Select All (Deselect) (Edit menu)  103
Sharpen (Image menu)  105
Undo (Redo) (Edit menu)  102
View By (Image menu)  107
Zoom In (Image menu)  104
Zoom Out (Image menu)  104
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communications regulation information
vii-viii

computer screen, scanning resolution 
for  52

connecting scanner
to Automatic Document Feeder  10
to Macintosh  13–15
SCSI cable  14
to Transparent Media Adapter  10

contrast
adjusting in images  78
changing  53–54

Contrast option (Select a Range)  54
Copy command (Edit menu)  102
copying selections  75, 102
copyright regulations  59
cover  10–11, 31
Crop command (Image menu)  105
cropping

adjusting  38
scanned image  84, 105

custom installation  21
custom settings for scanning  51–55
Cut command (Edit menu)  102
cutting and pasting selections  75–76, 102

D

darkness level (threshold)  55–56
dashed line (marquee)  66
delivery guide sheet, replacing  130–133
destination, indicating  36
dialog boxes

Apple Color OneScanner  36, 50
ColorSync Preferences  87
Resize  82
Scanner Install Script  21
Scan Router  42
TextBridge  93
Threshold  56
Tone  54
Unsharp Masking  80

diffuser
cleaning  150
location  139

dimensions, changing  57
disks

backing up  20
installation  19

Dispatcher, assigning fax applications 
to  42

Dispatcher command (Window 
menu)  108

Dispatcher window  24, 32, 46–48, 89
document feeder. See Automatic

Document Feeder
document glass, cleaning  112
documents. See also originals

copying an image into  75
placing on glass  29
problems in document feeder  117
restrictions  28
sizes  153

dots per inch, setting  51–52
drag-and-drop icons  24

in Dispatcher window  34, 47–48
TextBridge application  89

drawing lines  71
drawings and calligraphy. See originals
driver for scanner  19

E

Easy Install  21
editing images  33
editing tools  63, 68–74
Effects command (Image menu)  106
Ektapress film  148
Ektar 100 film  148
electrostatic buildup  8
environment for scanner  8, 154
EPS (Encapsulated PostScript Language)

image format  41
eraser tool (tool palette)  64, 109
erasing  64, 70, 109
extension cords  9
external SCSI devices  7
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F

fax applications
assigning to Dispatcher  42
sending new images to  33
sending saved images to  34

Fax drag-and-drop icon  34, 42
faxing images  34, 42–43

directly from scanner  42–43
scanning resolution  52
stored image  45–46

file formats
choosing  100
text  91

files
image format  41
installing for scanning  20–22

film
aligning  146
dirty  152
handling  141
inserting into film guide  142–144
light correction zone  146
overexposure  142
scanning  137
selecting type  148
sizes for scanning  142

fingerprints, avoiding  144
Flip command (Image menu)  106
flipping scanned images  84, 106
foreground color, changing  64, 108–109
foreground color tool (tool palette)  64
formats

choosing  100
for scanned images  41
text  91

G

Get Info command (File menu)  100
GIF image format  41
glass, cleaning  112
grabber (Threshold dialog box)  55–56

grabber tool (tool palette)  64, 108
graphics applications, scanning into

49–50
grayscale art  42–43
Gray Scale image option  36
grounding plug  15

H

Halftone image option  36
hard disk drive, requirements  2, 20
Hide (Show) Brushes command

(Window menu)  108
Hide (Show) Colors command (Window

menu)  108
Hide (Show) Tools command (Window

menu)  107
Highlight dropper (Threshold dialog 

box)  56
Horizontal flips  84
HTML documents

converting text image to  94
opening  43–44

HTML format, saving files to  89
Hypertext Markup Language (HTML)

43–44, 89, 94

I

icons
drag-and-drop  24, 34, 47–48
OCR  25
OneScanner Dispatcher  23, 32, 155
unassigned  47–48

ID number, setting  12
Image Depth command (Image 

menu)  106
image document. See scanned images
Image Edit button  33
image-editing tools  64–74, 108–110
Image1 document  39
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images. See also scanned images;
scanning images

automatic adjustments  38–39
changing ruler units  57
changing size  39
choosing type  36
custom options  51–56
depth  87
editing  33
editing tools  64, 68–74, 108–109
faxing or printing from scanner  42–43
from film  137
formats  41
opening saved  44
previewing  37, 63
printing or faxing saved images

45–46
quality problems  150–152
renaming  40–41, 45
saving documents  40–41
scanning options  36–38
selecting name  63
sending to printer or fax  33
sharpening  105
sideways  84
specifying type of  42
from transparencies  137
upside-down  84

information, reference  3
inkjet printer, scanning resolution  52
installation disks  19–20
Installer program  19
installing

Apple Color OneScanner plug-in
module  22–23

scanner software  20–22
Transparent Media Adapter  137–141

interference
electromagnetic  9
radio and television  vii

internal termination, SCSI  13
Internet

converting text files for  94
image format for  41

Invert command (Image menu)  104
irregular shape, selecting  67

J

JPEG (Joint Photographic Experts
Group) image format  41

K

Kai’s Power Tools and Convolver,
installing  26

L

lamp, in Transparent Media Adapter  150
laser printer, scanning resolution  52
lasso tool (tool palette)  64, 108
legal-size paper, in document feeder  118
light, power on  10
light correction zone  146, 150
line, dashed  66
line art  28
line drawings, sending from scanner

42–43
Linotronic imagesetter, scanning

resolution  52
loading Automatic Document Feeder

118–119
locking scanner  11

M

MacDraw Pro application, scanning
images for  47–48, 49

Macintosh
connecting scanner in SCSI chain

163–166
connecting SCSI cable  14

Macintosh PowerBook, connecting SCSI
power devices  13

Macintosh skills, help with  2
Macintosh IIfx, connecting scanner to  6
magazines. See originals
maintaining Automatic Document Feeder

cleaning  129
replacing delivery guide sheet

130–133
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maintenance
scanner  111–112
Transparent Media Adapter  149–150

marquee  66
memory

and image resolution  42
requirements  2

messages
application can’t find the scanner  156
computer can’t see document 

feeder  158
not enough space on hard disk  157

monitor, frozen  156
moving selections  68

N

names of images  39
negatives

avoiding overexposure  142–143
scanning  77, 137

New Archive command (File menu)  98
New Image command (File menu)  97
New Scan command (File menu)  97
noises, strange  157

O

OCR (optical character recognition)
icons  25
installing  23–25
scanning  90–91

OCR-to-HTML converter  89
OneScanner Dispatcher application

automatic settings  35–39
buttons  33
disks  19
Edit menu commands  102–103
File menu commands  96–102
icon  23, 32
image-editing tools  108–109
Image menu commands  103–107
opening  32, 62

organization  33–34
sending text to Xerox TextBridge

application  89–93
setting up transparencies  147–148
Window menu commands  107–108

on/off switch  10, 16
Open Archive command (File menu)  99
Open Image command (File menu)  98
optical character recognition programs.

See OCR
orientation, automatic setting  38
originals

aligning  29–30
damaged  121
loading multiple  113
preparing  28
problems with  117
scannable  28, 117
using Automatic Document Feeder

118–120
output devices, setting scanning

resolution  52
overexposure, avoiding  142
overhead transparencies  137
overheating  8

P

packing scanner  11
Page Setup command (File menu)  101
paintbrush tool (tool palette)  64, 109
paint bucket  64
paint bucket tool (tool palette)  109
painting

with brushes  72
spray  71

painting tools, setting shape for  64
palettes. See also editing tools

showing and hiding  65
paper. See originals
paper jams

clearing  123–128
diagram of path  122
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paper separator, replacing  134–136
Paste command (Edit menu)  103
pasting selections  75, 103
Pencil tool (tool palette)  64, 109
peripheral cable, SCSI  6
photographs. See also originals

handling film  141
printing  101
scanning  137
sending from scanner  42–43

Photoshop-compatible plug-in filters  106
Photoshop image format  41
PICT image format  41
plug-in module

installing  22–23, 26
using with graphic applications  49–50

positive images  77
power, switching on and off  16
PowerBook computer, connecting

scanner to  6
power cord  6

connecting  15
extension  9
socket  10

power on light  10, 155
going on and off  156

power requirements  154
power source  8
precautions, safety  9
preview image  37–38
Print Archive View command (File

menu)  102
Print command (File menu)  101
Print drag-and-drop icon  34
printer

receiving images from scanner  42–43
sending new images to  33
sending saved images to  34

printing
saved images  45–46
from scanner  33–34

Q

Quit command (File menu)  102

R

radio interference  vii
RAM requirements  2, 20
Read Me file  19
regular shape, selecting  66
removing scanner cover  31
renaming saved image  45
replacing scanner cover  31
requirements, system  2, 20
Resize command (Image menu)  105
Resize dialog box  82
resolution

automatic setting  37
custom setting  51–52
recommended  52
of scanned images  39

restarting computer  22
retaining clips  14
Revert command (File menu)  101
Rotate command (Image menu)  106
rotating scanned images  85, 106
ruler units  58

S

safety
features  15
precautions  9, 17

Save As command (File menu)  101
Save command (File menu)  100
saved images

opening from archive  43
printing or faxing  45–46

Scan button (Dispatcher window)  33
scanned images

adjusting brightness and color  78
changing color balance  79
changing view of archives  88
choosing format  40–41
copying  75–76
cropping  83
customizing  55–57
cutting  75–76
deleting  75–76
editing tools  68–75
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flipping  84
inverting from positive to negative  77
opening  62–63
poor quality  150–152
resizing  82
saving  40–41, 100
selecting  66–67
sending to fax application or printer

42–43
setting ColorSync preferences  87
setting image depth  86
sharpening  80–81
using palettes  64–65

Scanned Text window  93
scanner

adapting for transparencies  137
carrying  9
choosing location  7–8
cleaning  111–112
connecting  6–7
connecting power cord  15
connecting to Macintosh  13–14
connecting Transparent Media

Adapter  138–141
cover  31
driver  19
locking or unlocking  11
maintenance  111–112
moving or shipping  11
parts  10
placing  8
removing and replacing scanner 

cover  31
repacking  11
safety information  17
setting SCSI ID number  12
setting up document feeder  113–116
technical specifications  153–154
troubleshooting  155–157
unpacking  6
uses  1

scanner files, installing  20–22

scanner icon  155
Scanner Install Script dialog box  21
scanning area, extending  28
scanning images. See also Automatic

Document Feeder; Transparent
Media Adapter

automatic settings  35–39
changing image size and ruler units

57–58
custom settings  51–56
Dispatcher window  33–34
with document feeder  118–120
film  145–148
into graphics application  49–50
new  33
opening OneScanner Dispatcher

application  32
preparing originals  28–30
printing  45–46
saving  40–41, 43–44
scannable items  28
sending to fax application or printer

42–43, 45–46
setting options  36–38
transparencies  145–148
troubleshooting  158
using Transparent Media Adapter  137

scanning text
for use with OCR documents  89
into Xerox TextBridge application

90–93
Scan Router button (Dispatcher 

window)  33
Scan Router command (File menu)  99
Scan Router dialog box  42
scratches, on Transparent Media 

Adapter  148
scrolling image  39
SCSI cable

choosing  6–7
connecting  13
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SCSI chain
assembling  162–166
connecting devices  7, 161–162
ID numbers  159–160
termination  160–161

SCSI connectors  10
SCSI drivers, power-on sequence

114, 138
SCSI ID and termination selector  10
SCSI ID number and termination,

selecting  12–13, 155
Select All (Deselect) command (Edit

menu)  103
selection marquee (dashed line)  38
Selection rectangle tool (tool palette)

64, 108
setup

Automatic Document Feeder  113–116
scanner  5
Transparent Media Adapter  137–141

Shadow dropper (Threshold dialog box)
55–56

shapes, selecting  67
Sharpen command (Image menu)  105
sharpening images  80–81
shutter strips  142–144
Smudge tool (tool palette)  64, 109
smudging  74
software

installing for scanner  19–25
requirements  2

Source pop-up menu, dim  158
spray can tool (tool palette)  64, 109
spray painting  71
static buildup  8
straighten image  38
switch

on/off  10, 16
SCSI ID selector  12

switching, power on  16
system cable, SCSI  6
system hangs  156
system requirements  2, 20

T

technical specifications  153–154
television interference  vii
termination. See also SCSI chain

settings  13
terminators, purchasing  6
text

adding  64, 70
moving into Xerox TextBridge

application  92–93
scanning into Xerox TextBridge

application  90–91
text and optical character, scanning  28
TextBridge application. See Xerox

TextBridge application
TextBridge dialog box  93
text images, converting to HTML  94
text/line art  42
Text tool (tool palette)  64, 109
threshold, changing  55–57
Threshold dialog box  55–57
thumbnail representations  41, 43–44
TIFF (Tagged-Image File Format) image

format  41, 91
tone

adjusting  36
custom settings  53–55

Tone dialog box  54
tool palette

for editing  64
image editing  64
image-editing tools  108–109
showing and hiding  65

tools, editing  64, 68–74, 108–109
transparencies

dirty  152
scanning  145–148

Transparent Media Adapter
bypassing  148
connector  10
handling film  141
indicating source of scan  36
inserting film for scanning  142–144
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maintenance  149–150
overexposure  142, 152
scanning film and transparencies

145–148
setting up  137–141
troubleshooting  150–152
unlocking  139

transparent media alignment guide  139
troubleshooting

Automatic Document Feeder  158
image quality  158
scanning and hardware  155–157
Transparent Media Adapter  150–152

U

Unassigned drag-and-drop icons  34
Undo (Redo) command (Edit menu)

76, 102
unlocking scanner  11
Unsharp Masking dialog box  80

V

Vertical flips  84
vibrations  8
View By command (Image menu)  107
virus-detection programs  20

W

whole image, selecting and deselecting
67

windows
Dispatcher  24, 32, 46–48, 89
Scanned Text  93

Windows BMP image format  41
work areas  8–9

X, Y

Xerox TextBridge application  89
assigning to Dispatcher  23–25
converting files to text in HTML

format  94
installing  90
moving text into  92–93
scanning into  90–91

Z

Zoom In command (Image menu)  104
zooming in and out  69, 76, 104
Zoom Out command (Image menu)  104
Zoom button (Threshold dialog box)

55–56
Zoom tool (tool palette)  64, 109
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